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Introduction

Thanks for choosing Wingware’s Wing IDE Personal! This manual will help you get started
and serves as a reference for the entire feature set of this product.

The manual is organized by major functional area of Wing IDE, including source code
editor, project manager, and debugger. Several appendices document the entire command
set, provide pointers to resources and tips for Wing and Python users, and list the full
software license.

The rest of this chapter describes how to install and start using Wing IDE Personal. If
you hate reading manuals, you should be able to get started by reading this chapter only,
or try the quick start guide or tutorial.

Key Concepts

Throughout this manual, key concepts, important notes, and non-obvious features are
highlighted in the same way as this paragraph. If you are skimming only, look for
these marks.

1.1. Product Levels

This manual is for the Wing IDE Personal product level of the Wing IDE product line,
which currently includes Wing IDE Professional, Wing IDE Personal, and Wing IDE 101.

Wing IDE Professional is the full-featured Wing IDE product, and may be licensed for
commercial or non-commercial uses. Wing IDE Personal is for non-commercial use only
and contains a subset of the features found in Wing IDE Professional. Both products are
commercial products for sale from our website; Wing IDE Personal is not a free download.

Wing IDE 101 is a heavily scaled back IDE that was designed for teaching entry level
computer science courses. It is free to download and use for educational and personal use.
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Wing IDE Professional, Wing IDE Personal, and Wing IDE 101 are independent products
and may be installed at the same time on your system without interfering with each other.

For a list of features in each product level, please refer to http://wingware.com/wingide /features.

1.2. Licenses

Wing IDE is licensed per developer, and requires a separate license for each class of oper-
ating system (Windows, Linux, or OS X) that is used by the developer. For the full license
text, see the Software License.

License Activation

To run for more than 10 minutes, Wing IDE requires activation of a time-limited trial
or permanent purchased license. Time-limited trials last for 10 days and can be renewed
several times.

An activation ties the license to the machine through a series of checks of the hardware
connected to the system. This information is never transmitted over the internet. Instead
an SHA hash of some of the values is passed back and forth so that the machine will be
identifiable without us knowing anything specific about it.

The machine identity metrics used for activation are designed to be forgiving so that
replacing parts of your machine’s hardware or upgrading the machine will usually not
require another activation. By the same token, activating multiple times on the same
machine (for example if the activation file is lost) usually does not increase your activation
count.

Licenses come with three activations by default and additional activations can be obtained
from the self-serve license manager or by emailing sales at wingware.com. As a fall-back in
cases of emergency where we cannot be contacted and you don’t have an activation, Wing
IDE will run for 10 minutes at a time without any license at all.

See Installing Your License for more information on obtaining and activating licenses.

1.3. Supported Platforms

This version of Wing IDE is available for Microsoft Windows, Linux, Mac OS X (with
X11 Server), and some other operating systems where customers compile the product from
source code.


http://wingware.com/wingide/features
http://wingware.com/license
mailto:sales@wingware.com
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Microsoft Windows

Wing IDE supports Windows 2000, XP, 2003 Server, and Vista. Windows 95, 98, and ME
are not supported and will not work. Windows N'T'4 is not supported but may work with
[E5+ installed.

Linux/Intel

Wing IDE runs on Linux versions with glibc2.2 or later (e.g. RedHat 7.1+, Mandrake
8.0+, SUSE 7.1+, and Debian 3.0+).

On Suse, you may need to install the gmp and python packages, or install Python from
source, since Python is not installed by default here.

Mac OS X

Wing IDE runs on Mac OS X 10.3.94. Wing IDE for OS X also requires an X11 Server
and Window Manager. For details see OS X Quick Start Guide.

Only Python 2.2 and later are supported for Mac OS X. OS X 10.3 and later come with a
standard version of Python already installed.

Other Platforms

Wing IDE can be compiled from source by customers wishing to use it on other operat-
ing systems (such as Linux PPC, Free BSD, or Solaris). This requires a non-disclosure
agreement.

Some contributed builds of Wing IDE for other operating systems may be available from
time to time.

1.4. Supported Python versions

Wing supports CPython 2.0 through 3.1, Stackless Python 2.4 and 2.6, and cygwin Python
2.2 through 2.5. Wing can also be used with IronPython and Jython, but the debugger
will not work with these implementations of Python.

Wing’s debugger is pre-built for each of these versions of Python with and without --
with-pydebug. Both 32-bit and 64-bit compilation are supported on Windows and Linux.
CPython --with-framework builds are also supported on OS X. If necessary, it is possible
for customers to compile Wing’s debugger against other custom versions of Python.


http://wingware.com/pub/wingide/support/source-non-discl.pdf
http://wingware.com/pub/wingide/support/source-non-discl.pdf
http://wingware.com/downloads/contrib
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Before installing Wing, you may need to download Python and install it if you do not
already have it on your machine.

On Windows, Python must be installed using one of the installers from the python.org (or
by building from source if desired).

On Linuz, most distributions come with Python. Installing Python is usually only neces-
sary on SUSE or a custom-built Linux installation.

On SUSE Linuz, you can install the gmp and python packages that come with your dis-
tribution, or install from the materials available through the links given above.

On Mac OS X, Wing IDE only supports Python 2.2 and later.

1.5. Technical Support

If you have problems installing or using Wing IDE, please submit a bug report or feedback
using the Submit Bug Report or Submit Feedback items in Wing IDE’s Help menu.

Wingware Technical Support can also be contacted by email at support at wingware.com,
or online at http://wingware.com /support.

Bug reports can also be sent by email to bugs at wingware.com. Please include your OS
and product version number and details of the problem with each report.

If you are submitting a bug report via email, see Obtaining Diagnostic Output for more
information on how to capture a log of Wing IDE and debug process internals. Whenever
possible, these should be included with email-based bug reports.

1.6. Prerequisites for Installation

To run Wing IDE, you will need to obtain and install the following, if not already on your
system:

Prerequisites for all platforms:

e Downloaded or CD version of Wing IDE

e A supported version of Python


http://python.org/download
mailto:support@wingware.com
http://wingware.com/support
mailto:bugs@wingware.com
http://wingware.com/downloads
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e A working TCP/IP network configuration (for the debugger; no outside access to the
internet is required)

Additional Prerequisities for Mac OS X:

e An X11 window server, such as Apple X11 for OS X (available on the OS X install
disks) or XDarwin.

e A window manager. Apple’s X11 Server includes one; other options include Window
Maker and OroborOSX

See the OS X How-To for details on installing and using Wing on OS X.

1.7. Installing

Before installing Wing IDE, be sure that you have installed the necessary prerequisites.
If you are upgrading from a previous version, see Upgrading first.

Note: On all platforms, the installation location for Wing IDE is referred to as WINGHOME.
Windows 2000 and XP

Install Wing IDE by running the downloaded executable. Wing’s files are installed by
default in C:\Program Files\Wing IDE Personal 3.2, but this location may be modified
during installation. Wing will also create a User Settings Directory in the location
appropriate for your version of Windows. This is used to store preferences and other
settings.

The Windows installer supports a /silent command line option that uses the default
options, including removing any prior install of version 3.2 of Wing IDE. If a prior install
is removed, a dialog with a progress bar will appear. You can also use a /dir=<dir name>
option to specify an alternate installation directory.

Linux (glibc 2.2+)

Use the RPM, Debian package, or tar file installer as appropriate for your system type.
Installation from packages is at /usr/lib/wingide-personal3.2 or at the selected loca-
tion when installing from the tar file. Wing will also create a User Settings Directory
in 7/ .wingpersonal3, which is used to store preferences and other settings.

For more information, see the Linux installation details.


http://www.xdarwin.org/
http://www.windowmaker.info/
http://www.windowmaker.info/
http://oroborosx.sourceforge.net/
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Mac OS X 10.3+

Wing IDE on Mac OS X requires that you first install an X11 Server. For details on
installing and running on OS X, see the OS X Quickstart.

1.8. Running the IDE

For a quick introduction to Wing’s features, refer to the Wing IDE Quickstart Guide.
For a more gentle in-depth start, see the Wing IDE Tutorial.

On Windows, start Wing IDE from the Program group of the Start menu. You can also
start Wing from the command line with wing-personal.exe (located inside WINGHOME).

On Linux/Unix, just execute wing-personal3.2 (or wing-personal located inside
WINGHOME)

On Mac OS X, start Wing IDE by double clicking on the app folder. If you launch Wing
from the command line using Contents/Mac0S/wing inside the Wing IDE app folder, then
you will need to start your X11 Server manually first and may need to set your DISPLAY
environment variable.

1.9. Installing your License

Wing IDE requires a time-limited trial or permanent license and the license needs to be
activated on each machine (see the Licenses section for general information). When Wing
IDE is first started, you can obtain a trial licence, purchase a permanent license, install &
activate a permanent license, or use Wing for up to 10 minutes without any license:

No License Found =10 x]

Wing is running without a valid license. You may now:
E Obtain or extend a trial license
Purchase a permanent license

Install and activate a permanent license.
Enter license id:

10 minute emergency sessian

P continue| X Cancel
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Trial Licenses

Trial licenses allow evaluation of Wing IDE for 10 days, with an option to extend the
evaluation twice for up to 30 days total (or more on request). The most convenient way to
obtain a trial license is to ask Wing IDE to connect directly to wingware.com (via http,
TCP/IP port 80). After the trial license is obtained, Wing will not attempt to connect to
wingware.com (or any other site) unless you submit feedback or a bug report through the
Help menu.

Activate Trialllicense

o ConnectWing IDE directly to wingware.com

Activate manually at http:/fwingware.com/activate. You
will need your license id TMX3P-BFECQ-CYW59-6QF2T
and request code RLX24-LEWNK-DGEEX-HMTWL. Then
enter the provided activation key here:

9 continue| X cancel

If you're unable or unwilling to connect Wing IDE directly to wingware.com, you can
go to http://wingware.com/activate and enter the license id and activation request num-
ber obtained from Wing. After entering this information, you will be given an activation
key which you can enter into Wing’s dialog box to complete the activation. This is ex-
actly the same exchange of information that occurs when Wing IDE connects directly to
wingware.com to obtain a trial license.

If activation fails, Wing will provide a way to configure an http proxy. Wing tries to detect
and use proxies by default but in some cases they will need to be manually configured.
Please ask your network administrator if you do not know what proxy settings to use.

If you run into problems or need additional evaluation time, please email us at sales at
wingware.com.

Permanent Licenses

Permanent licenses and upgrades may be purchased in the online store at
http://wingware.com/store. Permanent licenses include free upgrades through the 3.*
version series. Wing IDE Professional licenses also allow access to the product source code
via http://wingware.com/downloads (requires signed non-disclosure agreement).

Activating on Shared Drives

When Wing is installed on a shared drive (for example a USB keydrive, or on a file server),


http://wingware.com/activate
mailto:sales@wingware.com
mailto:sales@wingware.com
http://wingware.com/store
http://wingware.com/downloads
http://wingware.com/pub/wingide/support/source-non-discl.pdf
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the User Settings Directory where the license activation is stored may be accessed from
several different computers.

In this case, Wing must be activated once on each computer. The resulting extra activations
will be stored as license.actl, license.act2, and so forth, and Wing will automatically
select the appropriate activation depending on where it is running.

Obtaining Additional Activations

If you run out of activations, you can use the self-serve license manager or email us at sales
at wingware.com to obtain additional activations on any legitimately purchased license.

1.10. User Settings Directory

The first time you run Wing, it will create your User Settings Directory automatically.
This directory is used to store your license, preferences, auto-save files, recent lists, and
other files used internally by Wing. If the directory cannot be created, Wing will exit.

The settings directory is created in a location appropriate to your operating system. The
location is listed as your Settings Directory in the About Box accessible from the Help
menu.

These are the locations used by Wing;:
Linux/Unix -- “/.wingpersonal3 (a sub-directory of your home directory)

Windows -- In Wing Personal 3 within the per-user application data directory. The
location varies by version of Windows. For Windows 2000 and XP running on ¢: with an
English localization the location is:

c:\Documents and Settings\${usernamel}\Application Data\Wing Per-
sonal 3

For Vista running on c: with an English localization the location is:
c:\Users\${username}\AppData\Roaming\Wing Personal 3

Wing also creates a Cache Directory that contains the source analysis cache. This is often
but not always in the same location as the above. On Windows, this directory is usually in
the per-user directory under Local Settings on 2000 and XP and under Local on Vista.
This directory is also listed in the About Box.


http://wingware.com/license
mailto:sales@wingware.com
mailto:sales@wingware.com
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1.11. Upgrading

If you are upgrading within the same minor version number of Wing (for example from
3.0 to 3.0.x) this will replace your previous installation. Once you have upgraded, your
previous preferences and settings should remain and you should immediately be able to
start using Wing.

If you are upgrading across major releases (for example from 2.1 to 3.0), this will install
the new version along side your old version of Wing.

To install an upgrade, follow the steps described in Installing

1.11.1. Fixing a Failed Upgrade

In rare cases upgrading may fail to overwrite old files, resulting in random or bizarre
behaviors and crashing. The fix for this problem is to completely uninstall and manually
remove remaining files before installing the upgrade again.

Windows

To uninstall on Windows, run the Add/Remove Programs control panel to uninstall Wing
IDE. Then go into the directory where Wing was located and manually remove any re-
maining folders and files.

Linux RPM

If you installed Wing IDE for Linux from RPM, issue the command rpm -e wingide3.2.
Then go into /usr/lib/wingide3.2 and remove any remaining files and directories.

Linux Debian

If you installed Wing IDE for Linux from Debian package, issue the command dpkg -r
wingide3.2. Then go into /usr/lib/wingide3.2 and remove any remaining files and
directories.

Linux Tar

If you installed Wing IDE for Linux from the tar distribution, find your Wing installation
directory and run the wing-uninstall script located there. Once done, manually remove
any remaining files and directories.

Mac OS X
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On Mac OS X, just drag the entire Wing IDE application folder to the trash.

If this procedure does not solve the problem, try moving aside the User Settings Direc-
tory and then starting Wing. If this works, try restoring files from the old user settings
directory one by one to find the problem. Key files to try are license.act*, preferences

and recent*. Then submit a bug report to support@wingware.com with the offending
file.

1.12. Installation Details and Options

This section provides some additional detail for installing Wing and describes installation
options for advanced users.

1.12.1. Linux Installation Notes

On Linux, Wing can be installed from RPM, Debian package, or from tar archive. Use the
latter if you do not have root access on your machine or wish to install Wing somewhere
other than /usr/lib/wingide-personal3.2. Be sure too use the 64-bit packages if you
are on a 64-bit system.

Installing from RPM:

Wing can be installed from an RPM package on RPM-based systems, such as RedHat and
Mandriva. To install, run rpm -i wingide-personal3.2-3.2.0-1.1i386.rpm as root or
use your favorite RPM administration tool to install the RPM. Most files for Wing are
placed under the /usr/1ib/wingide-personal3.2 directory and the wing-personal3.2
command is placed in the /usr/bin directory.

Installing from Debian package:

Wing can be installed from a Debian package on Debian, Ubuntu, and other Debian-based
systems.

You will need to install enscript before installing Wing, if it’s not already on your system.
To install, run dpkg -i wingide-personal3.2_3.2.0-1_i386.deb

as root or use your favorite package administration tool to install. Most files for Wing are
placed under the /usr/1ib/wingide-personal3.2 directory and the wing-personal3.2
command is placed in the /usr/bin directory.
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Installing from Tar Archive:

Wing may also be installed from a tar archive. This can be used on systems that do
not use RPM or Debian packages, or if you wish to install Wing into a directory other
than /usr/lib/wingide-personal3.2. Unpacking this archive with tar -zxvf wingide-
personal-3.2.0-1-1386-1inux.tar.gz will create a wingide-personal-3.2.0-1-1386-
linux directory that contains the wing-install.py script and a binary-package.tar file.

Running the wing-install.py script will prompt for the location to install Wing, and
the location in which to place the executable wing-personal3.2. These locations default
to /usr/local/lib/wingide-personal and /usr/local/bin, respectively. The install
program must have read/write access to both of these directories, and all users running
Wing must have read access to both.

Using System-wide GTK:

By default, Wing IDE runs with its own copy of GTK2 and does not pick up on the
system-configured theme. This is done to avoid problems and bugs sometimes brought out
by binary incompatibilities in GTK versions.

On Linux versions that include GTK version 2.6 or later, you can tell Wing IDE to use
the system-defined GTK2 by setting the System GTK preference or running with the
--system-gtk command line argument.

Using the system-wide GTK2 in this way generally works quite well but may result in
crashing or display bugs due to binary incompatibilities in GTK and related libraries. If
you set the preference and Wing fails to start, specify the -—private-gtk command line
option to override the preference.

Non-ascii File Paths on Older Linux Systems:

Some older Linux versions require setting the environment  variable
G_BROKEN_FILENAMES before Wing IDE’s file open/save dialog will work prop-
erly with file paths that contain non-ascii characters. The environment variable is already
set on some systems where it is needed but this is not always the case.

Debugging 32-bit Python on 64-bit Systems

On a 64-bit system where you need to debug 32-bit Python, you will need to install the
32-bit version of Wing. This version can also debug 64-bit Python.

Installing the 32-bit version of Wing may require installing some compatibility packages as
follows:

On 64-bit Ubuntu and Debian systems, you need to first install the 32 bit compatibil-
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ity libraries. This is the“ia32-libs* package on Ubuntu. On Debian and Ubuntu 94, the
ia32-1libs-gtk package is needed as well. Then install the 32-bit Wing with the command
dpkg -i --force-architecture wingide-personal3.2_3.2.0-1_.1i386.deb The pack-
age contains what you need to run your debug process with 64-bit Python but Wing itself
runs as a 32-bit application.

On CentOS 64-bit systems, installing the 1ibXtst.i386 and gtk2*386 packages with yum
provides the necessary 32 bit support.

1.12.2. Installing Extra Documentation

If you are using Linux/Unix, the Python manual is not included in most installations, so
you may also wish to download and install local copies of these pages.

Place the top-level of the HTML formatted Python manual (where index.html is found)
into python-manual/#.# within your Wing IDE installation. Substitute for #.# the major
and minor version of the corresponding Python interpreter (for example, for the Python
2.3.x manual, use python-manual/2.3).

Once this is done, Wing will use the local disk copy rather than going to the web when the
Python Manual item is selected from the Help menu.

1.13. Removing Wing IDE

Windows

On Windows, use the Add/Remove Programs control panel, select Wing IDE Personal 3
and remove it.

Linux/Unix
To remove an RPM installation on Linux, type rpm -e wingide-personal3.2.
To remove an Debian package installation on Linux, type dpkg -r wingide-personal3.2.

To remove a tar archive installation on Linux/Unix, invoke the wing-uninstall script in
WINGHOME. This will automatically remove all files that appear not to have been changed
since installation, It will ask whether it should remove any files that appear to be changed.

Mac OS X


http://docs.python.org/download.html
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To remove Wing from Mac OS X, just drag its application folder to the trash.

1.14. Command Line Usage

Whenever you run wing-personal3.2 from the command line, you may specify a list of
files to open. These can be arbitrary text files and a project file. For example, the following
will open project file myproject.wpr and also the three source files mysource.py, README,
and Makefile:

wing-personal3.2 mysource.py README Makefile myproject.wpr

(on Windows, the executable is called wing-personal.exe)

Wing determines file type by extension, so position of the project file name (if any) on the
command line is not important. A line number may be specified for the first file on the
command line by appending :<line-number> to the file name (for example, README: 100
will position the cursor at the start of the README file).

The following valid options may be specified anywhere on the command line:

--prefs-file -- Add the file name following this argument to the list of preferences files
that are opened by the IDE. These files are opened after the system-wide and default user
preferences files, so values in them override those given in other preferences files. Note
that preferences files added this way must have all the preferences in a section delim-
ited by [extra-preferences] (unlike the main user preferences file, which uses [user-
preferences]).

--new -- By default Wing will reuse an existing running instance of Wing IDE to open
files specified on the command line. This option turns off this behavior and forces creation
of a new instance of Wing IDE. Note that a new instance is always created if no files are
given on the command line.

--reuse -- Force Wing to reuse an existing running instance of Wing IDE even if there are
no file names given on the command line. This just brings Wing to the front.

--system-gtk -- (Posiz only) This option causes Wing to try to use the system-wide install
of GTK2 rather than its own version of GTK, regardless of any preference setting. Running
in this mode will cause Wing to pick up on system-wide theme defaults, but may result in
crashing or display problems due to incompatibilities in GTK and related libraries.

--private-gtk -- (Posiz only) This option causes Wing to use its private copy of GTK2
and related libraries, regardless of any preference settings. Use of private GTK may result
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in Wing not matching the system-wide theme, but also will avoid incompatibilities with
the system-wide GTK library.

--verbose -- (Posiz only) This option causes Wing to print verbose error reporting output
to stderr. On Windows, run console_wing.exe instead for the same result.

--display -- (Posiz only) Sets the X Windows display for Wing to run with. The display
specification should follow this argument, in standard format, e.g. myhost:0.0.

--use-winghome -- (For developers only) This option sets WINGHOME to be used during
this run. It is used internally and by developers contributing to Wing IDE. The directory
to use follows this argument.

--use-src -- (For developers only) This option is used to force Wing to run from Python
source files even if compiled files are present in the bin directory, as is the case after a
distribution has been built.

--orig-python-path -- (For developers only) This option is used internally to indicate the
original Python path in use by the user before Wing was launched. The path follows this
argument.

--squelch-output -- (For developers only) This option prevents any output of any kind
to stdout and stderr. Used on Windows to avoid console creation.



Customization

There are many ways to customize Wing IDE in order to adapt it to your needs or prefer-
ences. This chapter describes the options that are available to you.

These are some of the areas of customization that are available:

e The editor can run with different personalities such as Vim, Emacs, Visual
Studio, and Brief emulation

e The action of the tab key can be configured

e The auto-completer’'s completion key(s) can be altered

e The layout, look, and content of the IDE windows can be configured

e Keyboard shortcuts can be added, removed, or altered for any Wing command
e File sets can be defined to control some of the IDE features

e Many other options are available through preferences

2.1. Editor Personalities

The default editor personality for Wing implements most common keyboard equivalents
found in a simple graphical text editor. This uses primarily the graphical user interface for
interacting with the editor and limits use of complex keyboard-driven command interaction.
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Emulation of Other Editors

The first thing any Vim, Emacs, Visual Studio, or Brief user will want to do is to set the
editor personality to emulate their editor of choice. This is done with the Keyboard
Personality item in the Edit menu or with the Keyboard / Personality user
interface preference.

Under the Vim and Emacs personalities, key strokes can be used to control most of the
editor’s functionality, using a textual interaction 'mini-buffer’ at the bottom of the editor
window where the current line number and other informational messages are normally
displayed.

Related preferences that alter keyboard behaviors include Tab Key Action and Com-
pletion Keys for the auto-completer.

It is also possible to add, alter, or remove individual keyboard command mappings within
each of these personalities. See Key Equivalents for details.

2.2. User Interface Options

Wing provides many options for customizing the user interface to your needs. Preferences
can be set to control the number and style of windows used when working with the IDE,
the layout of tools within windows, display text font, size, and color, the style and content
of the toolbar, and the overall look or “theme” (including white on black and many others).

2.2.1. Windowing Policies

Wing IDE can run in a variety of windowing modes. This is controlled by the Windowing
Policy preference, which provides the following options:

e Combined Tool Box and Editor Windows -- This is the default, in which Wing
opens a single window that combines the editor area with two tool box panels.

e Separate Tool Box Windows -- In this mode, Wing IDE moves all the tools out
to a separate shared window.

e One Window Per Editor -- In this mode, Wing IDE creates one top-level window
for each editor that is opened. Additionally, all tools are moved out to a separate
shared tool box window and the toolbar and menu are moved out to a shared tool-
bar /menu window.



25

The windowing policy is used to describe the initial configuration and basic action of
windows in the IDE. When it is changed, Wing will reconfigure your projects to match the
windowing policy the first time they are used with the new setting.

However, it is possible to create additional IDE windows and to move editors and tools
out to another window or among existing windows without changing from the default
windowing policy. This is described below.

2.2.2. User Interface Layout

When working in the default windowing policy, Wing’s main user interface area consists of
two tool boxes (by default at bottom and right, but this can be altered in Preferences)
and an area for source editors and integrated help.

Clicking on an already-active notebook tab will cause Wing to minimize the entire panel
so that only the notebook tabs are visible. Clicking again will return the tool box to its
former size. The F1 and F2 keys toggle between these modes. The command Maximize
Editor Area in the Tools menu (Shift-F2) can also be used to quickly hide both tool areas
and toolbar.

In other windowing modes, the tool boxes and editor area are presented in separate windows
but share many of the configuration options described below.

Configuring the Toolbar

Wing’s toolbar can be configured by altering the size and style of the toolbar icons in
the toolbar, and whether or not text is shown in addition to or instead of icons. This is
controlled with the Toolbar Icon Size and Toolbar Icon Style preferences.

Alternatively, the toolbar can be hidden completely with the Show Toolbar preference.
Configuring the Editor Area

The options drop down menu in the top right of the editor area allows for splitting and
joining the editor into multiple independent panels. These can be arranged horizontally,
vertically, or any combination thereof. When multiple splits are shown, all the open files
within the window are available within each split, allowing work on any combination of
files and/or different parts of the same file.

The options drop down menu can also be used to change between tabbed editors and editors
that show a popup menu for selecting among files (the latter can be easier to manage with
large number of files) and to move editors out to a separate window or among existing
windows when multiple windows are open.
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Configuring Tool Boxes

Each of the tool boxes can be also be split or joined into any number of sub-panels along
the long axis of the notebook by clicking on the options drop down icon in the tab area of
the notebooks (right-clicking also works). The number of tool box splits Wing shows by
default depends on your monitor size.

The options drop down menu can also be used to duplicate tools, or move them around
among the splits or out to separate windows.

The size of each panel and the panel splits can also be altered by dragging on the dividers
between them.

All available tools are enumerated in the Tools menu, which will display the most recently
used tool of that type or will add one to your window at its default location, if none is
already present.

Creating Additional Windows

In addition to moving existing editors or tools to new windows, it is also possible to create
new tool windows (initially with a single tool) and new document windows (with editor
and toolbars if applicable to the selected windowing policy) from the Windows menu.

Wing IDE will remember the state of all windows as part of your project file, so the same
window layout and contents will be restored in subsequent work sessions.

2.2.3. Altering Text Display

Wing tries to find display fonts appropriate for each system on which it runs, but many users
will want to customize the font style and size used in the editor and other user interface
areas. This can be done with the Source Code Font/Size and Display Font/Size
preferences.

The color of text for some file types in the editor can be controlled with the Syntax
Formatting preference.

Note that when the Source Code Background preference is set to a color other than
white, Wing will compute appropriately visible colors for text according to the chosen
background color.

The color used for text selection can also be controlled with the Text Selection Color
preference.
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Changes in color preferences will often depend on the overall display theme that is chosen,
as described in the next section.

2.2.4. Setting Overall Display Theme

Wing is based on GTK2, a cross-platform user interface toolkit that provides customizable
themes, which control the overall look and feel of the user interface. Wing’s default theme
varies by platform (a Windows emulation theme is used on Windows, and an OS X like
theme on OS X) and can be changed with the Display Theme preference.

In most cases, the new theme will instantly be applied to Wing’s user interface. When
switching back to default settings, a restart may be needed in some cases, as indicated by
message dialog.

Some systems with slower graphics cards may not run as well using the more colorful 3D
rendered themes. In this case, using the Gtk Default theme is the best option, as it
involves no extra graphics-level processing.

System GTK on Linux

On Linux systems with GTK 2.6 or later installed, it is possible to run Wing with the
system-wide GTK installation and system-defined themes. This is controlled with the
Use System GTK preference or the ——system-gtk or —-private-gtk command line
arguments. Wing works reasonably well with most 2.6.x GTK2 releases, but there still
may be problems resulting from version differences. If you have any problems with Wing’s
stability or are seeing display glitches, you should use the private gtk option.

2.3. Preferences

Wing has many preferences that control features of the editor, debugger, and other tools.

To alter these, use the Preferences item in the Edit menu. This organizes all available
preferences by category and provides access to documentation in tooltips that are displayed
when mousing over the label area to the left of each preference. Any non-default values
that are selected through the Preferences Dialog are stored in the user’s preferences file,
which is located in the User Settings Directory.
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2.4. Key Equivalents

The command a key will invoke may be modified by selecting a different key map or by
specifying a custom key binding. A custom key binding will override any binding for a
particular key found in the keymap. Custom key bindings are set via the Custom Key
Bindings preference.

To add a binding, click the insert button, then press the key to be bound in the Key field,
and enter the name of the command to invoke in the Command field.

Key bindings defined by default or overriden by this preference will be shown in any menu
items that implement the same command. In cases where a command is given more than
one key equivalent, only the last equivalent found will be displayed (although both bindings
will work from the keyboard).

Key maps

Wing ships with several key equivalency maps found in WINGHOME, including
keymap.normal, keymap.emacs, keymap.vi, among others. These are used as default
key maps for the corresponding editor personalities.

For developing entirely new key bindings or debugging key bindings, it is possible to create
a custom key equivalency map and use it as your default map through Key Map File
preference. This is not recommended for most users, since completely replacing the default
key maps will require manual tracking of changes in commands across Wing versions.

In a key map file, each key equivalent is built from names listed in the Key Names section.
These names can be combined as follows:

1) A single unmodified key is specified by its name alone, for example
’Down’ for the down arrow key.

2) Modified keys are specified by hyphenating the key names, for exam-
ple *shift-Down’ for the down arrow key pushed while shift is held
down. Multiple modifiers may also be specified, as in ’ctrl-shift-
Down’.

3) Multi-key combinations can be specified by listing multiple key names
separated by a space. For example, to define a key equivalent that
consists of first pushing ctrl-x and then pushing the a key by itself,
use ’ctrl-x a’ as the key sequence.

The command portion of the key equivalency definition may be any of the commands listed
in section Command Reference. Use None to remove the given key equivalent entirely.
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Specifying a key binding that already exists in the default key binding simply replaces that
binding with your override.

Examples

Here is an example of adding a key binding for a command. If the command already has
a default key binding, both bindings will work:

’Ctrl-X P’: ’debug-attach’
This example removes a key equivalent entirely:
’Ctrl-C Ctrl-C’: None

These can be combined to changes the key binding for a command without retaining its
default key binding:

’Ctrl-C Ctrl-C’: None
’Ctrl-G’: ’debug-continue’

Wing always retains only the last key binding for a given key combination. This example
binds Ctrl-X to ’quit’ and no other command:

’Ctrl-X’: ’debug-stop’
’Ctrl-X’: ’quit’

2.4.1. Key Names

(1) Key modifiers supported by Wing IDE for key bindings are:

e Ctrl -- Either control key.

e Shift - Either shift key. This modifier is ignored with some key names, as indicated
below.

e Alt -- Not recommended for general use since these bindings tend to conflict with
menu accelerators and operating system or window manager operations.
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e Command -- Macintosh command / apple key. This may be mapped to other keys
on other systems, but is intended for use on the Macintosh.

On Linux and OS X it is possible to remap the function of the Control, Alt, command, and
windows keys. In those cases, the Ctrl and Alt modifiers will refer to the keys specified in
that mapping.

(2) The digit keys and core western alphabet keys are specified as follows:

07 ]‘7 27 37 47 57 67 77 87 97 A'7 B7 C7 D? E7 F? G7 H? 17 J’ K’ L7 M? N’ O? P7 Q? R’? S7 T7 U7 v?
W, X, Y, Z,

(3) Most punctuation can be specified but any Shift modifier will be ignored since these keys
can vary in location on different international keyboards. Allowed punctuation includes:

Crrte#$8h & x () -_+=01{FNI ;2" /70>, <

(4) These special keys can also be used:

Escape, Space, BackSpace, Tab, Linefeed, Clear, Return, Pause, Scroll_Lock, Sys_Req,
Delete, Home, Left, Up, Right, Down, Prior, Page_Up, Next, Page_Down, End, Begin,
Select, Print, Execute, Insert, Undo, Redo, Menu, Find, Cancel, Help, Break, Mode_switch,
script_switch, Num_Lock,

F1, F2, F3, F4, F5, F6, F7, F8, F9, F10, F11, L1, F12, L2, F13, L3, F14, L4, F15, L5,
F16, L6, F17, L7, F18, L8, F19, L9, F20, L10, F21, R1, F22, R2, F23, R3, F24, R4, F25,
R5, F26, R6, F27, R7, F28, R8, F29, R9, F30, R10, F31, R11, F32, R12, F33, R13, F34,
R14, F35, R15,

(5) For equivalents that work with the mouse buttons, use these:

Pointer_Left, Pointer_Right, Pointer_Up, Pointer_Down, Pointer_UpLeft,
Pointer_UpRight, Pointer_DownlLeft, Pointer_DownRight, Pointer_Button_DAlt,
Pointer_Buttonl, Pointer_Button2, Pointer_Button3, Pointer_Button4, Pointer_Buttonb,
Pointer_DblClick_Dfit,  Pointer_DblClickl, = Pointer_DblClick2,  Pointer_DblClick3,
Pointer_DblClick4, Pointer_DblClick5, Pointer_Drag_DAlt, Pointer_Dragl,
Pointer_Drag2, Pointer_Drag3, Pointer_Drag4, Pointer_EnableKeys, Pointer_Accelerate,
Pointer_DfltBtnNext, Pointer_DfitBtnPrev,

(6) Keypad keys are specified like this:

KP_Left, KP_Right, KP_Up, KP_Down, KP_Home, KP_Page Up, KP_Page Down,
KP_End, KP_Insert, KP_Delete, KP_0, KP_1, KP_2, KP_3, KP_4, KP_5, KP_6, KP_7,
KP_8, KP_9,
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(7) These will also work but ignore the Shift modifier since they tend to appear in different
locations on international keyboards:

KP_Space, KP_Tab, KP_Enter, KP_F1, KP_F2, KP_F3, KP_F4, KP_Prior, KP_Next,
KP_Begin, KP_Insert, KP_Delete, KP_Equal, KP_Multiply, KP_Add, KP_Separator,
KP_Subtract, KP_Decimal, KP_Divide,

exclam, quotedbl, numbersign, dollar, percent, ampersand, apostrophe, quoteright, paren-
left, parenright, asterisk, plus, comma, minus, period, slash, colon, semicolon, less, equal,
greater, question, at, bracketleft, backslash, bracketright, asciicircum, underscore, grave,
quoteleft, braceleft, bar, braceright,

EuroSign, EcuSign, ColonSign, CruzeiroSign, FFrancSign, LiraSign, MillSign, NairaSign,
PesetaSign, RupeeSign, WonSign, NewSheqelSign, DongSign,

(8) Many other key names are available for use on international or special purpose key-
boards:

asciitilde, nobreakspace, exclamdown, cent, sterling, currency, yen, brokenbar, section, di-
aeresis, copyright, ordfeminine, guillemotleft, notsign, hyphen, registered, macron, degree,
plusminus, twosuperior, threesuperior, acute, mu, paragraph, periodcentered, cedilla, one-
superior, masculine, guillemotright, onequarter, onehalf, threequarters, questiondown,

leftradical, topleftradical, horizconnector, topintegral, botintegral, vertconnector, topleft-
sqbracket, botleftsqbracket, toprightsqbracket, botrightsqbracket, topleftparens, botleft-
parens, toprightparens, botrightparens, leftmiddlecurlybrace, rightmiddlecurlybrace,
topleftsummation, botleftsummation, topvertsummationconnector, botvertsummationcon-
nector, toprightsummation, botrightsummation, rightmiddlesummation, lessthanequal,
notequal, greaterthanequal, integral, therefore, variation, infinity, nabla, approximate,
similarequal, ifonlyif, implies, identical, radical, includedin, includes, intersection, union,
logicaland, logicalor, partialderivative, function, leftarrow, uparrow, rightarrow, downar-
row, blank, soliddiamond, checkerboard, ht, ff, cr, 1f, nl, vt, lowrightcorner, upright-
corner, upleftcorner, lowleftcorner, crossinglines, horizlinescanl, horizlinescan3, horizli-
nescand, horizlinescan7, horizlinescan9, leftt, rightt, bott, topt, vertbar, emspace, en-
space, em3space, em4space, digitspace, punctspace, thinspace, hairspace, emdash, endash,
signifblank, ellipsis, doubbaselinedot, onethird, twothirds, onefifth, twofifths, threefifths,
fourfifths, onesixth, fivesixths, careof, figdash, leftanglebracket, decimalpoint, rightan-
glebracket, marker, oneeighth, threeeighths, fiveeighths, seveneighths, trademark, signa-
turemark, trademarkincircle, leftopentriangle, rightopentriangle, emopencircle, emopen-
rectangle, leftsinglequotemark, rightsinglequotemark, leftdoublequotemark, rightdouble-
quotemark, prescription, minutes, seconds, latincross, hexagram, filledrectbullet, filledleft-
tribullet, filledrighttribullet, emfilledcircle, emfilledrect, enopencircbullet, enopensquare-
bullet, openrectbullet, opentribulletup, opentribulletdown, openstar, enfilledcircbullet, en-
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filledsgbullet, filledtribulletup, filledtribulletdown, leftpointer, rightpointer, club, diamond,
heart, maltesecross, dagger, doubledagger, checkmark, ballotcross, musicalsharp, musi-
calflat, malesymbol, femalesymbol, telephone, telephonerecorder, phonographcopyright,
caret, singlelowquotemark, doublelowquotemark, cursor, leftcaret, rightcaret, downcaret,
upcaret, overbar, downtack, upshoe, downstile, underbar, jot, quad, uptack, circle, upstile,
downshoe, rightshoe, leftshoe, lefttack, righttack,

Multi_key, Codeinput, SingleCandidate, MultipleCandidate, PreviousCandidate, Kanji,
Muhenkan, Henkan_Mode, Henkan, Romaji, Hiragana, Katakana, Hiragana_Katakana,
Zenkaku, Hankaku, Zenkaku Hankaku, Touroku, Massyo, Kana_Lock, Kana_Shift,
Eisu_Shift, Eisu_toggle, Kanji_Bangou, Zen_Koho, Mae_Koho,

ISO_Lock, ISO_Level2_Latch, ISO_Level3_Shift, ISO_Level3_Latch, ISO_Level3_Lock,
I[SO_Group_Shift, I[SO_Group_Latch, I[SO_Group_Lock, ISO_Next_Group,
I[SO_Next_Group_Lock, ISO_Prev_Group, ISO_Prev_Group_Lock, ISO_First_Group,
ISO_First_Group_Lock, ISO_Last_Group, ISO_Last_Group_Lock, ISO_Left_Tab,
ISO_Move_Line_Up, ISO_Move_Line_Down, ISO_Partial Line_Up, ISO_Partial Line_Down,

ISO_Partial_Space_Left, ISO_Partial_Space_Right, ISO_Set_Margin_Left,
I[SO_Set_Margin_Right, [SO_Release_Margin_Left, [SO_Release_Margin_Right,
ISO_Release_Both_Margins, ISO_Fast_Cursor_Left, I[SO_Fast_Cursor_Right,
ISO_Fast_Cursor_Up, ISO_Fast_Cursor_Down, ISO_Continuous_Underline,

ISO_Discontinuous_Underline, ISO_Emphasize, ISO_Center_Object, ISO_Enter

dead_grave, dead_acute, dead_circumflex, dead_tilde, dead_macron, dead_breve,
dead_abovedot,  dead_diaeresis, dead_abovering, dead_doubleacute, dead_caron,
dead_cedilla, dead_ogonek, dead_iota, dead_voiced_sound, dead_semivoiced_sound,
dead_belowdot,

First_Virtual_Screen, Prev_Virtual_Screen, Next_Virtual Screen, Last_Virtual_Screen,
Terminate_Server, AccessX_Enable, AccessX_Feedback_Enable, RepeatKeys_Enable,
SlowKeys_Enable,  BounceKeys_Enable,  StickyKeys_Enable, = MouseKeys_Enable,
MouseKeys_Accel_Enable, Overlayl_Enable, Overlay2_Enable, AudibleBell_Enable,
Pointer_Left, Pointer_Right, Pointer_Up,

_3270_Duplicate,  _3270_FieldMark, _3270_Right2, 3270_Left2, _3270_BackTab,
_3270_EraseEOF, _3270_Eraselnput, 3270_Reset, _3270_Quit, _3270_PA1, _3270_PA2,
_3270_PA3, _3270_Test, 3270_Attn, _3270_CursorBlink, __3270_AltCursor, _3270_KeyClick,
3270_Jump,  _3270_Ident, _3270_Rule, _3270_Copy, _3270_Play, _3270_Setup,
3270_Record, _3270_ChangeScreen, __3270_DeleteWord, _3270_ExSelect, 3270_CursorS-
elect, _3270_PrintScreen, __3270_Enter,

Agrave, Aacute, Acircumflex, Atilde, Adiaeresis, Aring, AE, Ccedilla, Egrave, Eacute,
Ecircumflex, Ediaeresis, Igrave, lacute, Icircumflex, Idiaeresis, ETH, Eth, Ntilde, Ograve,
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Oacute, Ocircumflex, Otilde, Odiaeresis, multiply, Ooblique, Ugrave, Uacute, Ucircum-
flex, Udiaeresis, Yacute, THORN, Thorn, ssharp, agrave, aacute, acircumflex, atilde,
adiaeresis, aring, ae, ccedilla, egrave, eacute, ecircumflex, ediaeresis, igrave, iacute, icir-
cumflex, idiaeresis, eth, ntilde, ograve, oacute, ocircumflex, otilde, odiaeresis, division,
oslash, ugrave, uacute, ucircumflex, udiaeresis, yacute, thorn, ydiaeresis, Aogonek, breve,
Lstroke, Lcaron, Sacute, Scaron, Scedilla, Tcaron, Zacute, Zcaron, Zabovedot, aogonek,
ogonek, Istroke, lcaron, sacute, caron, scaron, scedilla, tcaron, zacute, doubleacute, zcaron,
zabovedot, Racute, Abreve, Lacute, Cacute, Ccaron, Eogonek, Ecaron, Dcaron, Dstroke,
Nacute, Ncaron, Odoubleacute, Rcaron, Uring, Udoubleacute, Tcedilla, racute, abreve,
lacute, cacute, ccaron, eogonek, ecaron, dcaron, dstroke, nacute, ncaron, odoubleacute,
udoubleacute, rcaron, uring, tcedilla, abovedot, Hstroke, Hcircumflex, Tabovedot, Gbreve,
Jeircumflex, hstroke, hcircumflex, idotless, gbreve, jcircumflex, Cabovedot, Ccircumflex,
Gabovedot, Gceircumflex, Ubreve, Scircumflex, cabovedot, ccircumflex, gabovedot, gcir-
cumflex, ubreve, scircumflex, kra, kappa, Rcedilla, Itilde, Lcedilla, Emacron, Gcedilla,
Tslash, rcedilla, itilde, lcedilla, emacron, gcedilla, tslash, ENG, eng, Amacron, logonek,
Eabovedot, Imacron, Ncedilla, Omacron, Kcedilla, Uogonek, Utilde, Umacron, amacron,
iogonek, eabovedot, imacron, ncedilla, omacron, kcedilla, uogonek, utilde, umacron, OE,
oe, Ydiaeresis, overline,

kana_fullstop, kana_openingbracket, kana_closingbracket, kana_comma, kana_conjunctive,
kana_middledot, kana_ WO, kana_a, kana_i, kana_u, kana_e, kana_o, kana_ya, kana_yu,
kana_yo, kana_tsu, kana_tu, prolongedsound, kana_A, kana_I, kana_U, kana_E, kana_O,
kana_KA, kana_KI, kana_KU, kana_KE, kana_KO, kana_SA, kana_SHI, kana_SU, kana_SE,
kana_SO, kana_TA, kana_CHI, kana_TI, kana_TSU, kana_TU, kana_TE, kana_TO,
kana_NA, kana_NI, kana_NU, kana_NE, kana_NO, kana_HA, kana_HI, kana_FU, kana_HU,
kana_HE, kana_ HO, kana_MA, kana MI, kana_ MU, kana ME, kana MO, kana_ YA,
kana_YU, kana_YO, kana_RA, kana_RI, kana_RU, kana_RE, kana_RO, kana_ WA, kana_N,

voicedsound, semivoicedsound, kana_switch,

Arabic_comma,  Arabic_semicolon,  Arabic_question_mark,  Arabic_hamza, Ara-
bic_maddaonalef, Arabic_hamzaonalef, Arabic_hamzaonwaw, Arabic_hamzaunderalef,
Arabic_hamzaonyeh, Arabic_alef, Arabic_beh, Arabic_tehmarbuta, Arabic_teh, Ara-
bic_theh, Arabic_jeem, Arabic_hah, Arabic_khah, Arabic_dal, Arabic_thal, Arabic_ra,
Arabic_zain, Arabic_seen, Arabic_sheen, Arabic_sad, Arabic_dad, Arabic_tah, Arabic_zah,
Arabic_ain, Arabic_ghain, Arabic_tatweel, Arabic_feh, Arabic_qaf, Arabic_kaf, Arabic_lam,
Arabic_meem, Arabic_noon, Arabic_ha, Arabic_heh, Arabic_waw, Arabic_alefmaksura,
Arabic_yeh, Arabic_fathatan, Arabic_.dammatan, Arabic_kasratan, Arabic_fatha, Ara-
bic_damma, Arabic_kasra, Arabic_shadda, Arabic_sukun, Arabic_switch,

Serbian_dje, = Macedonia_gje,  Cyrillic_io, = Ukrainian_ie, = Ukranian_je, = Macedo-
nia_dse, Ukrainian_i, Ukranian_i, Ukrainian_yi, Ukranian_yi, Cyrillic_je, Serbian_je,
Cyrillic_lje,  Serbian_lje, Cyrillic_nje, Serbian_nje, Serbian_tshe, Macedonia_kje,
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Ukrainian_ghe_with_upturn, Byelorussian_shortu, Cyrillic_dzhe, Serbian_dze, numerosign,
Serbian_DJE, Macedonia_GJE, Cyrillic_IO, Ukrainian_IFE, Ukranian_JE, Macedonia_DSE,
Ukrainian_I, Ukranian_I, Ukrainian_YI, Ukranian_YI, Cyrillic.JE, Serbian_JE, Cyril-
lic.LJE, Serbian_ LJE, Cyrillic.NJE, Serbian NJE, Serbian TSHE, Macedonia KJE,
Ukrainian GHE_WITH_UPTURN, Byelorussian SHORTU, Cyrillic. DZHE, Serbian_DZE,
Cyrillic_yu, Cyrillic_a, Cyrillic_be, Cyrillic_tse, Cyrillic_de, Cyrillic_ie, Cyrillic_ef, Cyril-
lic_ghe, Cyrillic_ha, Cyrillic_i, Cyrillic_shorti, Cyrillic_ka, Cyrillic_el, Cyrillic_em, Cyril-
lic_en, Cyrillic_o, Cyrillic_pe, Cyrillic_ya, Cyrillic_er, Cyrillic_es, Cyrillic_te, Cyrillic_u,
Cyrillic_zhe, Cyrillic_ve, Cyrillic_softsign, Cyrillic_yeru, Cyrillic_ze, Cyrillic_sha, Cyril-
lic_e, Cyrillic_shcha, Cyrillic_che, Cyrillic_hardsign, Cyrillic_.YU, Cyrillic_A, Cyrillic_BE,
Cyrillic_TSE, Cyrillic.DE, Cyrillic_LIE, Cyrillic_.EF, Cyrillic.GHE, CyrilliccHA, Cyril-
lic_I, Cyrillic.SSHORTI, Cyrillic. KA, Cyrillic_.EL, CyrilliccEM, Cyrillic.EN, Cyrillic_O,
Cyrillic_PE, Cyrillic_.YA, Cyrillic_ZER, Cyrillic_.ES, Cyrillic_.TE, Cyrillic_U, Cyrillic_ZZHE,
Cyrillic_VE, Cyrillic.SOFTSIGN, Cyrillic.YERU, Cyrillic_ZZE, Cyrillic.SHA, Cyrillic_E,
Cyrillic.SHCHA, Cyrillic. CHE, Cyrillic. HARDSIGN,

Greek_ALPHAaccent, Greek EPSILONaccent, Greek ETAaccent, Greek IOTAaccent,

Greek_10TAdiaeresis, Greek_ OMICRONaccent, Greek_UPSILONaccent,
Greek_UPSILONdieresis, Greek OMEGAaccent, Greek_accentdieresis, Greek_horizbar,
Greek_alphaaccent, Greek_epsilonaccent, Greek_etaaccent, Greek_iotaaccent,

Greek_iotadieresis, Greek_iotaaccentdieresis, Greek_omicronaccent, Greek_upsilonaccent,
Greek_upsilondieresis, Greek upsilonaccentdieresis, Greek_omegaaccent, Greek ALPHA,
Greek BETA, Greek GAMMA, Greek DELTA, Greek EPSILON, Greek ZETA,
Greek_ETA, Greek_THETA, Greek _IOTA, Greek_KAPPA, Greek_LAMDA,
Greek LAMBDA, Greek- MU, Greek NU, Greek XI, Greek OMICRON, Greek_PI,
Greek RHO, Greek SIGMA, Greek TAU, Greek UPSILON, Greek PHI, Greek CHI,
Greek_PSI, Greek OMEGA, Greek_alpha, Greek beta, Greek gamma, Greek delta,
Greek_epsilon, Greek_zeta, Greek_eta, Greek_theta, Greek_ iota, Greek kappa,
Greek_lamda, Greek_lambda, Greek_mu, Greek_nu, Greek xi, Greek_omicron, Greek_pi,
Greek_rho, Greek_sigma, Greek_finalsmallsigma, Greek_tau, Greek_ upsilon, Greek_phi,
Greek_chi, Greek_psi, Greek_omega, Greek_switch,

hebrew_doublelowline, hebrew_aleph, hebrew_bet, hebrew_beth, hebrew_gimel, he-
brew_gimmel, hebrew_dalet, hebrew_daleth, hebrew_he, hebrew_waw, hebrew_zain,
hebrew_zayin, hebrew_chet, hebrew_het, hebrew_tet, hebrew_teth, hebrew_yod, he-
brew_finalkaph, hebrew_kaph, hebrew_lamed, hebrew_finalmem, hebrew_mem, he-
brew_finalnun, hebrew_nun, hebrew_samech, hebrew_samekh, hebrew_ayin, he-
brew_finalpe, hebrew_pe, hebrew_finalzade, hebrew_finalzadi, hebrew_zade, hebrew_zadi,
hebrew_qoph, hebrew_kuf, hebrew_resh, hebrew_shin, hebrew_taw, hebrew_taf, He-
brew_switch,
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Thai_kokai, Thai_khokhai, Thai_khokhuat, Thai_khokhwai, Thai_khokhon,
Thai_khorakhang, = Thai ngongu, Thai chochan, Thai choching, Thai_chochang,
Thai_soso, Thai_chochoe, Thai_yoying, Thai_dochada, Thai_topatak, Thai_thothan,
Thai_thonangmontho, = Thai_thophuthao,  Thai_nonen, Thai_dodek, Thai_totao,
Thai_thothung, Thai_thothahan, Thai_thothong, Thai_nonu, Thai_bobaimai, Thai_popla,
Thai_phophung, Thai_fofa, Thai_phophan, Thai_fofan, Thai_phosamphao, Thai_moma,
Thai_yoyak, Thai_rorua, Thai_ru, Thai_loling, Thai_lu, Thai_wowaen, Thai_sosala,
Thai_sorusi, Thai_sosua, Thai_hohip, Thai_lochula, Thaioang, Thai_honokhuk,
Thai_paiyannoi, Thai_saraa, Thai_maihanakat, Thai_saraaa, Thai_saraam, Thai_sarai,
Thai_saraii, Thai_saraue, Thai_sarauee, Thai_sarau, Thai_sarauu, Thai_phinthu,

Thai_maihanakat_maitho, Thai_baht, Thai_sarae, Thai_saraae, Thai_sarao,
Thai_saraaimaimuan, Thai_saraaimaimalai, Thai_lakkhangyao, Thai_maiyamok,
Thai_maitaikhu, Thai_maiek, Thai_maitho, Thai_maitri, Thai_maichattawa,

Thai_thanthakhat, Thai_nikhahit, Thai_leksun, Thai_leknung, Thai_leksong, Thai_leksam,
Thai_leksi, Thai_lekha, Thai_lekhok, Thai_lekchet, Thai_lekpaet, Thai_lekkao,

Hangul, Hangul Start, Hangul End, Hangul Hanja, Hangul Jamo, Hangul Romaja,
Hangul Codeinput, Hangul Jeonja, Hangul Banja, Hangul PreHanja, Hangul_PostHanja,
Hangul SingleCandidate, Hangul MultipleCandidate, Hangul PreviousCandidate,
Hangul_Special, Hangul_switch, Hangul_Kiyeog, Hangul_SsangKiyeog, Hangul_KiyeogSios,
Hangul_Nieun, Hangul_NieunJieuj, Hangul_NieunHieuh, Hangul_Dikeud,
Hangul_SsangDikeud, Hangul _Rieul, Hangul RieulKiyeog, Hangul RieulMieum,
Hangul_RieulPieub, Hangul RieulSios, Hangul RieulTieut, Hangul _RieulPhieuf,
Hangul RieulHieuh, Hangul Mieum, Hangul Pieub, Hangul _SsangPieub,
Hangul_PieubSios, Hangul_Sios, Hangul_SsangSios, Hangul_leung, Hangul_Jieuj,
Hangul SsanglJieuj, Hangul Cieuc, Hangul Khieuq, Hangul Tieut, Hangul Phieuf,
Hangul Hieuh, Hangul A, Hangul_AE, Hangul YA, Hangul_YAE, Hangul EO, Hangul_E,
Hangul_ YEO, Hangul. YE, Hangul O, Hangul. WA, Hangul. WAE, Hangul OE,
Hangul YO, Hangul U, Hangul WEO, Hangul WE, Hangul WI, Hangul YU, Hangul EU,
Hangul_YI, Hangul I, Hangul J_Kiyeog, Hangul_J_SsangKiyeog, Hangul J_KiyeogSios,
Hangul_J_Nieun, = Hangul J_NieunJieuj, = Hangul_J_NieunHieuh, = Hangul J_Dikeud,
Hangul J_Rieul, Hangul J_RieulKiyeog, Hangul J_RieulMieum, Hangul J_RieulPieub,
Hangul J_RieulSios, Hangul J_RieulTieut, Hangul J_RieulPhieuf, Hangul J_RieulHieuh,
Hangul J_Mieum, Hangul _J_Pieub, Hangul _J_PieubSios, Hangul J_Sios,
Hangul_J_SsangSios, Hangul_J_leung, Hangul_J_Jieuj, Hangul_J_Cieuc, Hangul_J_Khieuq,
Hangul_J_Tieut, Hangul J_Phieuf, Hangul_J_Hieuh, Hangul_RieulYeorinHieuh,
Hangul_SunkyeongeumMieum, Hangul_SunkyeongeumPieub, Hangul_PanSios,
Hangul KkogjiDalrinleung, Hangul_SunkyeongeumPhieuf, Hangul YeorinHieuh,
Hangul_AraeA, Hangul AraeAE, Hangul J PanSios, Hangul J KkogjiDalrinleung,
Hangul_J_YeorinHieuh, Korean_Won,
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Armenian_eternity, Armenian_section_sign, Armenian_full_stop, Armenian_verjaket,
Armenian_parenright, Armenian_parenleft, Armenian_guillemotright, Arme-
nian_guillemotleft, ~Armenian_em_dash, Armenian_dot, Armenian_mijaket, Arme-
nian_separation_mark, Armenian_but, Armenian_comma, Armenian_en_dash, Ar-
menian_hyphen, Armenian_yentamna, Armenian_ellipsis, Armenian_exclam, Arme-
nian_amanak, Armenian_accent, Armenian_shesht, Armenian_question, Armenian_paruyk,
Armenian_AYB, Armenian_ayb, Armenian_BEN, Armenian_ben, Armenian_GIM, Arme-
nian_gim, Armenian_DA, Armenian_da, Armenian_ YECH, Armenian_yech, Armenian_ZA,
Armenian_za, Armenian_E;, Armenian_e, Armenian_AT, Armenian_at, Armenian_TO,
Armenian_to, Armenian_ZHE, Armenian_zhe, Armenian_INI, Armenian_ini, Arme-
nian_LYUN, Armenian_lyun, Armenian KHE, Armenian_khe, Armenian_TSA, Arme-
nian_tsa, Armenian_KEN, Armenian_ken, Armenian_HO, Armenian_ho, Armenian_DZA,
Armenian_dza, Armenian_ GHAT, Armenian_ghat, Armenian_TCHE, Armenian_tche, Ar-
menian_MEN, Armenian_men, Armenian_HI, Armenian_hi, Armenian_NU, Armenian_nu,
Armenian_SHA, Armenian_sha, Armenian_VO, Armenian_vo, Armenian_ CHA, Arme-
nian_cha, Armenian_PE, Armenian_pe, Armenian_JE, Armenian_je, Armenian_RA, Arme-
nian_ra, Armenian_SE, Armenian_se, Armenian_VEV, Armenian_vev, Armenian_TYUN,
Armenian_tyun, Armenian RE, Armenian re, Armenian_ TSO, Armenian_tso, Arme-
nian_VYUN, Armenian_vyun, Armenian PYUR, Armenian_pyur, Armenian KE, Arme-
nian_ke, Armenian_O, Armenian_o, Armenian FE, Armenian_fe, Armenian_apostrophe,
Armenian_ligature_ew,

Georgian_an, Georgian_ban, Georgian_gan, Georgian_don, Georgian_en, Georgian_vin,
Georgian_zen, Georgian_tan, Georgian_in, Georgian_kan, Georgian las, Georgian_man,
Georgian_nar, Georgian_on, Georgian_par, Georgian zhar, Georgian_rae, Georgian san,
Georgian_tar, Georgian_un, Georgian_phar, Georgian_khar, Georgian_ghan, Georgian_qar,
Georgian_shin, Georgian_chin, Georgian_can, Georgian_jil, Georgian_cil, Georgian_char,
Georgian_xan, Georgian_jhan, Georgian_hae, Georgian_he, Georgian_hie, Georgian_we,
Georgian_har, Georgian_hoe, Georgian_fi,

2.5. File Sets

Wing provides a way to define sets of files that can be used in various ways within the
IDE, such as for searching particular batches of files and adding only certain kinds of files
to a project.

To view or alter the defined file sets, use the File Sets... item in the File menu. This
will display a file set editor within the Preferences manager.

When adding or editing a file set, the following information may be entered:
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e Name - The name of the file set

e Includes -- A list of inclusion criteria, each of which contains a type and a specifica-
tion. A file will be included in the file set if any one of these include criteria matches
it.

e Excludes - A list of exclusion criteria, any of which can match to cause a file to be
excluded from the file set even if one or more include matches were also found.

The following types of include and exclude criteria are supported:

e Wildcard on Filename -- The specification in this case is a wildcard that must
match the file name. The wildcards supported are those provided by Python’s fn-
match module.

e Wildcard on Directory Name -- The specification in this case is a wildcard that
must match the directory name.

e Mime Type -- The specification in this case names a MIME type supported by
Wing IDE. If additional file extensions need to be mapped to a MIME type, use the
Extra File Types preference to define them.

Once defined, file sets are presented by name in the Search in Files tool’s batch search
facility and in the Project tool’s batch file addition features.

Any problems encountered in using the file sets are reported in the Messages area.


http://wingware.com/psupport/python-manual/2.5/lib/module-fnmatch.html
http://wingware.com/psupport/python-manual/2.5/lib/module-fnmatch.html
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Project Manager

The Project manager provides a convenient index of the files in your software project
and collects information needed by Wing’s debugger, source code analysis tools, and other
facilities.

To get the most out of Wing’s debugger and source analysis engine, you may in some cases
need to set up Python Executable, Python Path, and other values in Project-Wide
Properties and/or Per-File Properties.

NOTE: Wing IDE Personal omits some of the project manager features.

3.1. Creating a Project

To create a new project, use the New Project item in the Project menu. This will
prompt you to save any changes to your currently open project and will create a new
untitled project. If Wing is started without any command line arguments, the most recent
project is opened, or if no project exists then the Default Project is opened.

When you create a new project, you will often want to alter some of the Project Prop-
erties to point Wing at the version of Python you want to use, set PYTHONPATH so Wing’s
source analyzer and debugger can find your files, and set any other necessary runtime
environment for your code.

To add files to your project, use the following items in the Project menu:

e Add Directory allows you to specify a directory to include in the project. In many
cases, this is the only operation needed to set up a new project. You will be able to
specify a filter of which files to include, whether to include hidden & temporary files,
and whether to include subdirectories. The list of files in the project will be updated
as files matching the criteria are added and removed from the disk.

39



40

e Add Current File will add the frontmost current editor file to the project if it is
not already there.

e Add New File is used to create a new file and simultaneously add it to your project.

e Add File will prompt you to select a single file to add to the project view. Note
that this also may result in adding a new directory to the project manager window,
if that file is the first to be added for a directory.

A subset of these options can be accessed from the context menu that appears when right-
clicking your mouse on the surface of the project manager window.

3.2. Removing Files and Packages

To remove a specific file, select it and use the Remove From Project menu item in the
right-click context menu from the surface of the Project Manager window, or by selecting
an item on the project and using Remove Selected Entry in the Project menu. You can
also remove a whole directory and all the files that it contains in this way.

3.3. Saving the Project

To save a new project, use Save Project As in the Project menu. Once a project file
has been saved the first time, it will be auto-saved whenever you close the project, start a
debug session, or exit Wing.

You can also save a copy of your project to another location or name with Save Project
As... in the Project menu.

Moving Project Files

When moving a project file on disk, doing so in a file browser or from the command
line may partially break the project if it is moved relative to the position of files that
it includes. Using Save Project As... in Wing instead will properly update the
relative paths that the project manager uses to locate files in the project.
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3.4. Sorting the View

The project can be set to show your files in one of several modes, using the Options menu
in the top right of the project view:

e View As Tree -- This displays the project files in true tree form. The tree structure
is based on the partial relative path from the project file.

e View As Flattened Tree -- This view (the default) shows files organized according
to their location on disk. Each directory is shown at the top level with path names
shown as partial relative paths based on the location of the project file. If you alter
the location of the project file with Save Project As..., these paths will be updated
accordingly.

e View By Mime Type -- This view organizes your files by MIME type.

3.5. Navigating to Files

Files can be opened from the project manager window by double clicking or middle clicking
on the file name, or right-clicking and using the Open in Wing IDE menu item.

Files may also be opened using an external viewer or editor by right-clicking on the file and
using the Open in External Viewer item. On Windows and Mac OS X, this opens the file
as if you had double clicked on it. On Linux, the preferences File Display Commands
and Extra Mime Types can be used to configure how files are opened.

You can also execute Makefiles, Python source code, and any executable files by selecting
the Execute Selected File item from the popup menu. This executes outside of the debugger
with any input/output occurring in the OS Commands tool. Doing so also adds the
command to the OS Commands tool, where its runtime environment can be configured.

3.5.1. Keyboard Navigation

Once it has the focus, the project manager tree view is navigable with the keyboard, using
the up/down arrow keys, page up and page down, and home/end.

Use the right arrow key on a parent to display its children, or the left arrow key to hide
them.

Whenever a file is selected, pressing enter will open that item into an editor in Wing IDE.
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3.6. Project-wide Properties

Each project has a set of top-level properties that can be accessed and edited via the Prop-
erties item in the Project menu. These can be used to configure the Python environment
used by the debugger and the source code analysis engine, which drives Wing’s auto
completion, source index, and other capabilities. Project properties are also provided to set
options for the project and to enable and configure extensions for revision control, Zope,
and other tools.

Any string value for a property may contain environment variable references using the
$ (name) notation. Anything inside the parentheses will be interpreted as the name of an
environment variable and will be replaced with the value of the environment variable when
it used by the IDE. If the environment variable is not set, the reference will be replaced by
an empty string. The system environment, as modified by the project-wide environment
property (see below), is used to expand variable references.

Environment

To get the most out of Wing, it is important to set these values in the Environment tab
correctly for your project:

Python Executable -- When the Custom radio button is checked and the entered field
is non-blank, this can be used to set the full path to the Python executable that should be
used when debugging source code in this project. When Use default is selected, Wing tries
to use the default Python obtained by typing python on the command line. If this fails,
Wing will search for Python in /usr/local and /usr (on Linux/Unix) or in the registry
(on Windows).

Python Path -- The PYTHONPATH is used by Python to locate modules that are imported at
runtime with the import statement. When the Use default checkbox in this area is checked,
the inherited PYTHONPATH environment variable is used for debug sessions. Otherwise, when
Custom is selected, the specified PYTHONPATH is used.

Environment -- This is used to specify values that should be added, modified, or removed
from the environment that is inherited by debug processes started from Wing IDE and is
used to expand environment variable references used in other properties. Each entry is in
var=value form and must be specified one per line in the provided entry area. An entry
in the form var= (without a value) will remove the given variable so it is undefined. Note
that you are operating on the environment inherited by the IDE when it started and not
modifying an empty environment. When the Use system environment choice is set, any
entered values are ignored and the inherited environment is used without changes.
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Debug

The following properties are defined in the Debug tab:

Main Debug File -- This defines where execution starts when the debugger is launched
from the IDE. The default is to start debugging in the current editor file. Alternatively,
use this property to define a project-wide main debug file so that debug always started in
that file regardless of which file is current in the editor.

Initial Directory -- When the Use default radio button is checked, the initial working
directory set for each debug session will be the location where the main entry point file (if
any) or project file is located. Otherwise, when Custom is selected, the specified directory
is used or, when blank, the project file’s directory is used.

Python Options -- This is used to select the command line options sent to the Python
interpreter while debugging. The default of -u sets Python into unbuffered 1/O mode,
which ensures that the debug process output, including prompts shown for keyboard input,
will appear in a timely fashion.

Options

These project options are provided:

Default Encoding sets the default text encoding to use for files when the encoding cannot
be determined from the contents of the file. This applies to all files opened when the project
is open, whether or not they are part of the project. By default, this falls back to the value
set by the Default Encoding preference.

Project Home Directory sets the base directory for the project. This overrides the
project file location as the directory on which to base relative paths shown in the Project
view and elsewhere. It is also used as the directory in which the Python Shell subprocess
is launched and for the starting directory when the Default Directory Policy preference
is set to Current Project.

Preferred Line Ending and Line Ending Policy control whether or not the project
prefers a particular line ending style (line feed, carriage return, or carriage return + line
feed), and how to enforce that style, if at all. By default, projects do not enforce a line
ending style but rather insert new lines to match any existing line endings in the file.

Preferred Indent Style and Indent Style Policy control whether or not the project
prefers a particular type of indentation style for files (spaces only, tabs only, or mixed tabs



44

and spaces), and how to enforce that style, if at all. By default, projects do not enforce an
indent style but rather insert new lines to match any existing indentation in the file.

Extensions

The Extensions tab of Project Properties is used to control add-ons on a per-project basis:

Enable Zope2/Plone Support and Zope2 Instance Home are used for Zope 2.x and
Plone projects to provide the Instance Home directory used by Zope. This is needed because
Zope 2.x implements import magic that works differently from Python’s default import
and thus adding the instance home directory to PYTHONPATH is not sufficient. Wing’s
source analyzer needs this extra clue to properly find and process the Zope instance-specific
sources.

When this option is activated, Wing will also offer to add the relevant Zope2/Plone files
to the project, and to install the control panel for configuring and initiating debug in
Zope2/Plone. See the Zope How-To for details.

3.7. Per-file Properties

Per-file properties can be set by right-clicking on a source file and selecting the Properties
menu item in the popup, by right-clicking on a file in the project view and selecting File
Properties, or by opening a file and using the Current File Properties... item in
the Source menu. For Debug and Python Settings, values entered here will override any
corresponding project-wide values when the selected file is the current file or the main
entry point for debugging.

File Attributes

File Type -- This property specifies the file type for a given file, overriding the type deter-
mined automatically from its file extension and/or content. This property is recommended
only when the Extra File Types preference cannot be used to specify encoding based on
filename extension.

Encoding -- This can be used to specify the encoding with which a file will be saved.
When it is altered for an already-open file, Wing will offer to reload the file using the
new encoding, to only save subsequently using the new encoding, or to cancel the change.
Choose to reload if the file was opened with the wrong encoding. For already-open files,
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the encoding attribute change is only saved if the file is saved. If it is closed without saving,
the encoding attribute will revert to its previous setting. The encoding cannot be altered
with this property if it is being defined by an encoding comment in a Python, HTML,
XML, or gettext PO file. In this case, the file should be opened and the encoding comment
changed. Wing will save the file under the newly specified encoding.

Important: Files saved under a different encoding without an encoding comment may
not be readable by other editors because there is no way for them to determine the file’s
encoding if it differs from the system or disk default. Wing stores the selected encoding in
the project file, but no mark is written in the file except for those encodings that naturally
use a Byte Order Mark (BOM), such as utf_16_le, utf_16_be, utf_32_le, or utf_32_be. Note
that standard builds of CPython cannot read source files encoded in utfl6 or utf32.

Line Ending Style -- Specifies which type of line ending (line feed, carriage return, or
carriage return and line feed) is used in the file. When altered, the file will be opened and
changed in an editor. The change does not take effect until the file is saved to disk.

Indent Style -- This property can be used in non-Python files to change the type of
indent entered into the file for newly added lines. For Python files, the only way to alter
indentation in a file is with the Indentation manager.

Read-only on Disk -- This property reflects whether or not the file is marked read-only
on disk. Altering it will change the file’s disk protections for the owner of the file (on Posix,
group/world permissions are never altered).

Editor

These properties define how the file is displayed in the editor:

Show Whitespace -- This allows overriding the Show White Space preference on a
per-file basis.

Show EOL -- This allows overriding the Show EOL preference on a per-file basis.

Show Indent Guides -- This allows overriding the Show Indent Guides preference on
a per-file basis.

Ignore Indent Errors -- Wing normally reports potentially serious indentation inconsis-
tency in Python files. This property can be used to disable this check on a per-file basis
(it is also available in the warning dialog).

Ignore EOL Errors -- When the project’s Line Ending Policy is set to warn about
line ending mismatches, this property can be used to disable warnings for a particular file.
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Environment

These properties are the same as for the Python Settings defined in Project-Wide Prop-
erties. Values defined per-file override the corresponding project-wide property.

For the Environment attribute, note that the option menu area contains some additional
choices. Use Add to Project Values to apply the values specified here to the runtime
environment specified by the project, or Add to System Environment to bypass the project-
wide values and apply the per-file values directly to the environment set by the operating
system.

Debug

The per-file debug properties dialog contains all the same fields described in Project-Wide
Properties, with the following additions:

Run Arguments -- Enter any run arguments here. Wing does not interpret backslashes
(") on the command line and passes them unchanged to the debug process. The only
exceptions to this rule are \” and \" (backslash followed by single or double quote), which
allow inclusion of quotes inside quoted multi-word arguments.

Show this dialog before each run -- Check this checkbox if you want the debug options
dialog to appear each time you start a debug session.

Values defined per-file override or modify the corresponding project-wide property.

When debugging, only per-file debug properties set on the initially invoked file are used.
Even if other files with set properties are used in the debug session, any values set for them
will be ignored.



Source Code Editor

Wing IDE’s source code editor is designed to make it easier to adopt the IDE even if you
are used to other editors.

Key things to know about the editor

e The editor has personalities that emulate other commonly used editors such as
Visual Studio, VI/Vim, Emacs, and Brief.

e Context-appropriate auto-completion, goto-definition, and code index menus are
available when working in Python code

e The editor supports a wide variety of file types for syntax colorization.
e Key mappings and many other behaviors are configurable.

e The editor supports structural folding for some file types

4.1. Syntax Colorization

The editor will attempt to colorize documents according to their MIME type, which is
determined by the file extension, or content. For example, any file ending in .py will
be colorized as a Python source code document. Any file whose MIME type cannot be
determined will display all text in black normal font by default.

All the available colorization document types are listed in the File Properties dialog’s File
Attributes tab. If you have a file that is not being recognized automatically, you can
use the File Type menu found there to alter the way the file is being displayed. Your
selections from this menu are stored in your project file, so changes made are permanent
in the context of that project.
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If you have many files with an unrecognized extension, use the Extra File Types prefer-
ence to add your extension.

4.2. Right-click Editor Menu

Right-clicking on the surface of the editor will display a context menu with commonly
used commands such as Copy, Paste, Goto Definition, and commenting and indentation
operations.

4.3. Navigating Source

The set of menus at the top of the editor can be used to navigate through your source
code. Each menu indicates the scope of the current cursor selection in the file and may be
used to navigate within the top-level scope, or within sub-scopes when they exist.

When editor tabs are hidden by clicking on the options drop down in the top right of the
editor area, the left-most of these menus lists the currently open files by name.

You can also use the Goto Definition menu item in the editor context menu to click on a
construct in your source and zoom to its point of definition. Alternatively, place the cursor
or selection on a symbol and use the Goto Selected Symbol Defn item in the Source
menu, or its keyboard equivalent.

When moving around source, the history buttons in the top left of the editor area can be
used to move forward and backward through visited files and locations within a file in a
manner similar to the forward and back buttons in a web browser.

Other commonly used ways to select among files that are open include the Window menu,
which lists all open files, and the Recent sub-menu in the File menu.

Additionally, the Open From Keyboard command in the File menu can be a convenient
way to find files quickly. This operates in a temporary input area at the bottom of the
IDE window and offers auto-completion of file names as you type.



49

4.4. File status and read-only files

The editor tabs, or editor selection menu when the tabs are hidden, indicate the status of
the file by appending * when the file has been edited or (r/o) when the file is read-only.
This information is mirrored for the current file in the status area at the bottom left of
each editor window. Edited status is also shown in the Window menu by appending * to
the file names found there.

Files that are read-only on disk are initially opened within a read-only editor. Use the
file’s context menu (right-click) to toggle between read-only and writable state. This alters
both the editability of the editor and the writability of the disk file so may fail if you do
not have the necessary access permissions to make this change.

4.5. Transient vs. non-Transient Editors

Wing can open files in two modes:

Transient Mode -- Files opened when searching, debugging, navigating to point of def-
inition, and using the Project and (in Wing Pro only) the Source Browser tools with the
Follow Selection checkbox enabled are opened in transient mode and will be automati-
cally closed when hidden. The maximum number of non-visible transient files to keep open
at any given time can be set with the Editor / Advanced / Transient Threshold
preference.

Non-Transient Mode -- Files opened normally from the File menu, from the keyboard file
selector, or by double clicking on items in the Project tool will be opened in non-transient
mode, and kept open until they are explicitly closed.

A file can be switched between transient and non-transient mode by clicking on the stick
pin icon in the upper right of the editor area. Right-click on the stick pin icon to navigate
to recently visited files (blue items were transient, black items non-transient).

Transient files that are edited are also automatically converted to non-transient mode.

4.6. Auto-completion

While typing in Python source code, Wing Personal and higher will display a context-
appropriate auto-completion list. To use it, type until the correct symbol is hilighted in
the list (or use the up/down arrow keys) and then press the Tab key or double click on
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an item. Wing will fill in the remaining characters for the source symbol, correcting any
spelling errors you might have made in the name.

To alter which keys cause auto-completion to occur, use the Auto-completion Keys
preference. Ctrl-click on the list to select multiple keys.

To cancel out of the auto-completion popup, press the Esc key or ctrl-g. The auto-
completer will also disappear when you exit the source symbol (for example, by pushing
space or any other character that can’t be contained in a source symbol), if you click
elsewhere on the surface of the source code, or if you issue other keyboard-bound com-
mands that are not accepted by the auto-completer (for example, save through keyboard
equivalent).

Auto-completion Limitations

Auto-completion covers most but not all possible scenarios at this time. See section
Source Code Analysis for more information on current capabilities and how to help
Wing determine the types of values.

4.7. Indentation

Since indentation is syntactically significant in Python, Wing provides a range of features
for inspecting and managing indentation in source code.

4.7.1. How Indent Style is Determined

When an existing file is opened, it is scanned to determine what type of indentation is used
in that file. If the file contains some indentation, this may override the tab size, indent
size, and indent style values given in preferences and the file will be indented in a way that
matches its existing content rather than with your configured defaults. If mixed forms of
indentation are found, the most common form is used.

For non-Python files, you can change indentation style on the fly using the Indent Style
property in the File Properties dialog. This allows creating files that intentionally mix
indentation forms in different parts of the file. To ask Wing to return to the form of
indentation it determines as most prominent in the file, select Match Existing Indents.

For Python files, the Indent Style cannot be altered without converting the whole file’s
indent style using the Indentation Manager, which can be accessed from the button
next to the Indent Style property and from the Tools menu.



Tab Size

Tab size is automatically forced to 8 characters for all Python source files that contain
some spaces in indentation. This is done because the Python interpreter defines tabs
as 8 characters in size when used together with spaces. This version of Wing does
not recognize vi style tab size comments, but it does apply the Tab Size preference

when a file contains only tabs in indentation, or if it is a non-Python file.

4.7.2. Indentation Preferences

The

1)

following preferences affect how the indentation features behave:

The Use Indent Analysis preference is used to control whether analysis of
current file content is used to determine the type of indentation placed during
edits. It can be enabled for all files, only for Python files, or disabled. Note
that disabling this preference for Python files can result in a potentially broken
mix of indentation in the files. In general, indent styles should not be mixed
within a single Python file.

The Default Tab Size preference defines the position of tab stops and is
used to determine the rendering of files with tabs only, or non-Python files
with mixed tab and space indentation. In Python files with mixed indents,
this value is ignored and the file is always shown in the way that the Python
interpreter would see it.

The Default Indent Size preference defines the default size of each level of
indent, in spaces. This is used in new empty files or when indent analysis has
been disabled. Wing may override this value in files that contain only tabs in
indentation, in order to make it a multiple of the configured tab size.

The Default Indent Style preference defines the default indentation style,
one of spaces-only, tabs-only, or mixed. This is used in new empty files
or when indent analysis has been disabled. Mixed indentation replaces each
tab-size spaces with one tab character.

These preferences define how indentation is handled by the editor:

5)

The Auto-Indent preference controls whether or not each new line is auto-
matically indented.

ol
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6) The Show Indent Guides preference controls whether or not to show inden-
tation guides as light vertical lines. This value can be overridden on a file-by-file
basis from Editor tab in File Properties.

7) The Show Python Indent Warnings preference can be used to enable or
disable warnings for Python files that may contain confusing or damaged in-
dentation.

8) The Show Override Warnings preference controls whether or not Wing
shows a warnings when the user enters indentation that does not match the
form already within a file. This is currently only possible in non-Python files,
by altering the Indent Style attribute in File Properties.

4.7.3. Indentation Policy

The project manager also provides the ability to define the preferred indentation style
(overriding the preference-defined style) and to specify a policy for enforcing line endings,
on a per-project basis. This is accomplished with Preferred Line Ending and Line
Ending Policy under the Options tab in Project Properties.

4.7.4. Auto-Indent

The IDE ships with auto-indent turned on. This causes leading white space to be added
to each newly created line, as return or enter are pressed. Enough white space is inserted
to match the indentation level of the previous line, possibly adding or removing a level of
indentation if this is indicated by context in the source (such as if, while, or return).

Note that if preference Auto-indent is turned off, auto-indent does not occur until the
tab key is pressed.

4.7.5. The Tab Key

By default, the tab key either indents according to context or increases the indent depth at
the current cursor position by one level (this depends on the selected editor Personality).
If one or more lines are selected, this instead operates on the indentation of all selected
lines by one level.

To insert a real tab character regardless of the indentation mode or the position of the
cursor on a line, type Ctrl-Tab or Ctrl-T.
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The behavior of the tab key can be altered using the Tab Key Action preference.

4.7.6. Checking Indentation

Wing IDE analyzes existing indentation whenever it opens a Python source file, and will
indicate a potentially problematic mix of indentation styles, allowing you to attempt to
repair the file. Files can be inspected more closely or repaired at any time using the
Indentation Manager.

To turn off indentation warnings in Python files, use the Show Python Indent Warnings
preference.

Wing also indicates suspiciously mismatched indentation in source code by underlining the
indent area of the relevant lines in red or yellow. In this case, an error or warning message
is displayed when the mouse hovers over the flagged area of code.

4.7.7. Changing Block Indentation

Wing provides Indent and Outdent commands in the Indentation portion of the Source
menu, which increase or decrease the level of indentation for selected blocks of text. All
lines that are included in the current text selection are moved, even if the entire line isn’t
selected.

Indentation placed by these commands will contain either only spaces, only tabs, or a
mixture of tabs and spaces, as determined by the method described in Indentation.

Indenting to Match

The command Indent Lines to Match (also in the Indentation sub-menu) will
indent or outdent the current line or selected lines to the level as a unit so that the
first line is positioned as it would have been positioned by Wing's auto-indentation
facility. This is very useful when moving around blocks of code.

4.7.8. Indentation Manager

The Indentation manager, accessible from the Tools menu, can be used to inspect and
change indentation style in source files. It has two parts: (1) The indentation report, and
(2) the indentation converter.



o4

A report on the nature of existing indentation found in your source file is given above the
horizontal divider. This includes the number of spaces-only, tabs-only, and mixed tabs-and-
space indents found, information about whether indentation in the file may be problematic
to the Python interpreter, and the tab and indent size computed for that file. The manager
also provides information about where the computed tab and indent size value come from
(for example, an empty file results in use of the defaults configured in preferences).

Conversion options for your file are given below the horizontal divider. The three tabs are
used to select the type of conversion desired, and each tab contains information about the
availability and action of that conversion, and a button to start the conversion. In some
of the conversion options, the indent size field shown in the indentation report is made
editable, to allow specification of the desired resulting indent size.

Once conversion is complete, the indentation manager updates to display the new status
of the file, and action of any subsequent conversions.

Conversions can be undone be moving to the converted source file and selecting Undo from
the Edit menu.

4.8. Brace Matching

Wing will highlight matching braces in green when the cursor is adjacent to a brace.
Mismatched braces are highlighted in red.

You can cause Wing to select the entire contents of the innermost brace pair from the
current cursor position with the Match Braces item in the Source menu.

Parenthesis, square brackets, and curly braces are matched in all files. Angle brackets (<
and >) are matched also in HTML and XML files.

4.9. Support for files in .zip or .egg files

Source and other text files stored in .zip or .egg files may be loaded into the editor as
readonly files. Wing is unable to write changes to a file within a .zip or .egg file or
otherwise write to or create a .zip or .egg file.

When stepping through code, using goto definition, or using other methods to goto a line
in a file, a file within a .zip or .egg file will be opened automatically. To open a file through
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the open file dialog, specify the name of the .zip or .egg file and add a / followed by the
name of the file to open.

4.10. Notes on Copy/Paste

There are a number of ways to copy and paste text in the editor:

e Use the Edit menu items. This stores the copy/cut text in the system-wide clipboard
and can be pasted into or copied from other applications.

e Use key equivalents as defined in the Edit menu.
e Right-click on the editor surface and use the items in the popup menu that appears.

e Select a range of text and drag it using the drag and drop feature. The default drag
operation is to copy on Linux and OS X and move on Windows. Pressing the Control
key after starting the drag toggles between moving or copying the text.

e On Linux, select text anywhere on the display and then click with the middle mouse
button to insert it at the point of click.

e In emacs mode, ctrl-k (kill-line) will cut one line at a time into the private emacs
clipboard. This is kept separate from the system-wide clipboard and is pasted using
ctrl-y (yank-line). On Windows and Mac OS X, ctrl-y will paste the contents of
the system-wide clipboard only if the emacs clipboard is empty.

e In VI mode, named text registers are supported.

e On Windows and Mac OS X, click with the middle mouse button to insert the
current emacs private clipboard (if in emacs mode and the buffer is non-empty) or
the contents of the system-wide clipboard (in all other cases). On Mac OS X, the
middle mouse button is emulated by command or other key configured in the X11
Server’s preferences. This behavior may be disabled via the Middle Mouse Paste
preference

It is important to note which actions use the system-wide clipboard, which use the emacs
private clipboard or VI registers, and which use the X windows selection (X Windows
only). Otherwise, these commands are interchangeable in their effects.
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4.11. Auto-reloading Changed Files

Wing’s editor detects when files have been changed outside of the IDE and can reload files
automatically, or after prompting for permission. This is useful when working with an
external editor, or when using code generation tools that rewrite files.

Wing’s default behavior is to automatically reload externally changed files that have not

yet been changed within Wing’s source editor, and to prompt to reload files that have also
been changed in the IDE.

You can change these behaviors by setting the value of the Reload when Unchanged
and Reload when Changed preferences

On Windows, Wing uses a signal from the OS to detect changes so notification or reload is
usually instant. On Linux and Unix, Wing polls the disk by default every 3 seconds; this
frequency can be changed with the External Check Freq preference.

4.12. Auto-save

The source code editor auto-saves files to disk every few seconds. The auto-save files are
placed in a subdirectory of your User Settings Directory.

If Wing ever crashes or is killed from the outside, you can use these files to manually recover
any unsaved changes. Copy the auto-save files to overwrite the older unsaved files, doing
a comparison first to verify that the auto-save file is what you want.



Search /Replace

Wing provides a number of tools for search and replace in your source code. Which you
use depends on the complexity of your search or replace task and what style of searching
you are most familiar with.

5.1. Toolbar Quick Search

One way to do simple searches is to enter text in the search area of the toolbar. This scrolls
as you type to the next match found after the current cursor position. Pressing Enter will
search for each subsequent match, wrapping the search when the end of the file is reached.

Text matching during toolbar quick search is case-insensitive unless you enter a capital
letter as part of your search string.

If focus is off the toolbar search area and it already contains a search string, clicking on
it will immediately start searching in the current source editor for the next match. If
you wish to search for another string instead, delete the text and type the desired search
string. As you delete, the match position in the editor will proceed backward until it
reaches your original search start position, so that after typing your new search string you
will be presented with the first match after the original source editor cursor position.

5.2. Keyboard-driven Mini-Search/Replace

The Edit menu contains a Mini-Search sub-menu that enumerates the available keyboard-
driven search options. These are normally initiated with the keyboard command sequences
shown in the menu and can be controlled entirely by using the keyboard. All interaction
with the mini-search manager occurs using data entry areas displayed on demand at the
bottom of the IDE window.

o7
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The implementation of the mini-search manager is very close to the most commonly used
search and replace features found in Emacs, but it is available whether or not the Emacs
editor personality is being used.

The following search and replace features are available in this facility:

e Forward and Backward -- These display a search string entry area at the bottom of
the IDE window and interactively search forward or backward in the current source
editor, starting from the current cursor position. The search takes place as you type
and can be aborted with Esc or Ctr1-G, which returns the editor to its original cursor
location and scroll position.

Searching is case-insensitive unless you enter a capital letter as part of your search
string. To search repeatedly, press Ctrl-U (or Ctrl-S in emacs keyboard mode)
to search forward and ‘‘Ctrl-Shift-U (or Ctrl-R in emacs mode) to search in
reverse. The search direction can be changed any number of times and searching will
wrap whenever the top or bottom of the file is reached. You can also enter Ctr1-U (or
Ctrl-S in emacs mode) or Ctrl-Shift-U (or Ctrl-R in emacs mode) again initially
while the search string is still blank in order to call up the most recently used search
string and begin searching forward or backward with it.

Once the mini-search entry area is visible, Ctrl-W will add the current word in the
editor to the search string. Pressing Ctrl-W more than once while the mini-search
entry is visible adds additional words from the editor to the search string.

e Selection Forward and Selection Backward -- These work like the above but
start with the selection in the current source editor.

e Regex Forward and Regex Backward -- These work like the above but treat the
search string as a regular expression.

e Query/Replace and Regex Query/Replace -- This prompts for search and re-
place strings in an entry area at the bottom of the IDE window and prompts for
replace on each individual match found after the cursor location in the current source
editor. Press y to replace or n to skip a match and move on to the next one. The
interaction can be canceled at any time with Esc or -G. Matching is case insensitive
unless a capital letter is entered as part of the search string. Searching is always
forward and stops when the end of the file is reached, without wrapping to any un-
searched parts between the top of the file and the position from which the search was
started.

e Replace String and Replace Regex -- This works like the above command but
immediately replaces all matches without prompting.
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5.3. Search Tool

The dockable Search tool can be used for more advanced search and replace tasks within
the current editor. It provides the ability to customize case sensitivity and whole/part
word matching, search in selection, and perform wildcard or regex search and replace.

The Replace field may be hidden and can be shown from the Options menu in the bottom
right of the tool.

To the right of the Search and Replace fields, Wing makes available a popup that contains
a history of previously used strings, options for inserting special characters, and an option
for expanding the size of the entry area.

The following search options can be selected from the tool:
e Case Sensitive -- Check this option to show only exact matches of upper and lower
case letters in the search string.

e Whole Words -- Check this option to require that matches are surrounded by white
space (spaces, tabs, or line ends) or punctuation other than _ (underscores).

e In Selection -- Search for matches only within the current selection on the editor.
The following additional options are available from the Options popup menu:

e Show Replace -- Whether or not the Replace field is visible in the tool.
e Text Search -- Select this to do a regular text search without wildcard or regex.

e Wildcard Search -- Select this to allow use of special characters for wildcarding in
the search string (see Wildcard Search Syntax for details).

e Regex Search -- Select this to use regular expression style searching. This is a more
powerful variant than wildcard search that allows for more complex specification of
search matches and replacement values. For information on the syntax allowed for the
search and replace strings, see Python’s Regular Expression Syntax documentation.

e Wrap Search -- Uncheck this to avoid wrapping around when the search reaches
the top or bottom of a file.

e Incremental -- Check this to immediately start or restarted searching as you type
or alter search options. When unchecked, use the forward/backward search buttons
to initiate searching.


http://wingware.com/psupport/python-manual/2.5/lib/re-syntax.html
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e Find After Replace -- Select this to automatically find the next search match after
each Replace operation.

5.4. Search in Files Tool

The dockable Search in Files tool is used to search and replace within sets of files, or for
searching Wing’s documentation. It performs searches in batch and displays a result list
for all found matches. This list can then be traversed to view the matches in the source
editor, and is automatically updated as edits alter the search results.

Searching may span the current editor, a single selected file, all open files, all project files,
or all of Wing’s documentation.

Files in a set may be filtered by file type, for example searching only through Python files
in the project.

In addition the options also available in the search tool, the following choices are available

in the Options popup menu:

e Replace Operates On Disk -- Check this to replace text in un-opened files directly
on disk. Caution: see Replace in Multiple Files for details on this option.

e Omit Binary Files -- Check this to omit any file that appears to contain binary
data.

e Auto-restart Searches -- Check this to restart searching immediately if it is in-
terupted because a search parameter or the set of files being searched is changed.

e Open First Match -- Check this to automatically open the first batch search match,
even before the result list is clicked upon.

e Show Line Numbers -- Check this to include line numbers in the batch result area.

e Result File Name -- This is used to select the format of the result file name shown
in the batch result area.
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5.4.1. Replace in Multiple Files

For searches that operate on open files, replace always occurs in the open file editor and
can be undone or saved to disk subsequently, as with any other edit operation.

When replacing text in batch mode, some of the files being searched may not currently be
open in an editor. In this case, Wing will by default open all altered files and make changes
in newly created editors that remain open until the user saves and closes them explicitly.
This is the safest way to undertake multi-file global replace operations because it clearly
shows which files have been altered and makes it possible to undo changes.

An alternative approach is available by selecting the Replace Operates on Disk option
from the Options popup. This will cause Wing to change files directly on disk in cases
when there is no currently open editor.

Because global replace operations can be tricky to do correctly, we strongly recommend
using a revision control system or frequent backups and manually comparing file revisions
before accepting files that have been altered.

5.5. Wildcard Search Syntax

For wild card searches in the Search tools, the following syntax is used:

* can be used to match any sequence of characters except for line endings. For example,
the search string my*value would match anything within a single line of text starting
with my and ending with value. Note that * is “greedy” in that myinstancevalue =
myothervalue would match as a whole rather than as two matches. To avoid this, use
Regex Search instead with .*7 instead of *.

7 can be used to match any single character except for line endings. For example,
my??7?7value would match any string starting with my followed by three characters, and
ending with value.

[ and ] can be used to indicate sets of match characters. For example [abcd] matches any
one of a, b, ¢, or d. Also, [a-zA-Z] matches any letter in the range from a to z (inclusive),
either lower case or uppercase. Note that case specifications in character ranges will be
ignored unless the Case Sensitive option is turned on.
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Interactive Python Shell

Wing provides an integrated Python Shell for execution of commands and experimental
evaluation of expressions. The version of Python used in the Python Shell, and the envi-
ronment it runs with, is configured in your project using Project Properties.

This shell runs a separate Python process that is independent of the IDE and functions
without regard to the state of any running debug process.

Convenient ways to run parts of your source code in the shell include:

Copy /Paste part of a file - Wing will automatically adjust leading indentation so the
code can be executed in the shell.

Drag and Drop part of a file -- This works like Copy /Paste.

Evaluate File in Python Shell -- This command in the Source menu will evaluate the
top level of the current file in the shell.

Evaluate Selection in Python Shell -- The command in the Source menu and editor’s
context menu (right-click) will evaluate the current selection in the shell.

Options menu This menu in the Python Shell tool contains items for evaluating the
current file or selection

To restart the Python Shell, select Restart Shell from the Options menu in the top right
of the tool. This will terminate the external Python process and restart it, clearing and
resetting the state of the shell.

To save the contents of the shell, use Save a Copy in the Options menu or right-click
context menu. The right-click context menu also provides items for copying and pasting
text in the shell.
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6.1. Python Shell Auto-completion

Wing’s Python Shell includes auto-completion, which can be a powerful tool for quickly
finding and investigating functionality at runtime, for the purposes of code learning, or in
the process of crafting new code.

Unlike the auto-completer shown in the editor, the Python Shell’s completer is fueled with
actual data extracted from the runtime environment on the fly as you type.

6.2. Python Shell Options

The Options menu in the Python Shell contains some settings that control how the Python
Shell works:

e Wrap Lines causes the shell to wrap long output lines in the display

e Evaluate Whole Lines causes Wing to round up the selection to the nearest line
when evaluating selections, making it easier to select the desired range

e Auto-restart when Evaluate File causes Wing to automatically restart the shell
before evaluating a file, so that each evaluation is made within a clean new environ-
ment.



Debugger

Wing’s debugger provides a powerful toolset for rapidly locating and fixing bugs in single-
threaded or multi-threaded Python code.

The debugger is built around a TCP/IP client/server design that supports launching your
application not just from Wing itself but also externally, as with CGI scripts or code
running in an embedded scripting facility within a larger application. Remote (host to
host) debugging is also provided.

Because the debugger core is written in optimized C, debug overhead is relatively low;
however, you should expect your programs to run about 50% slower within the debugger.

7.1. Quick Start

Wing IDE can be used to debug all sorts of Python code, including scripts and stand-alone
applications written with wxPython, Tkinter, PyQt, PyGTK, and pygame. Wing can
also debug web CGIs including those running under mod_python, code running under
Zope, Plone, Turbogears, Django, Paste/Pylons, Twisted, and code running in an
embedded Python interpreter.

This section describes how to debug stand-alone scripts and applications that can be
launched from within Wing IDE. If you wish to debug web CGIs within the web server, web
servlets, or embedded Python scripts, please refer to Debugging Externally Launched
Code and, for remote host-to-host debugging, see Remote Debugging.

Before debugging, you will need to install Python on your system if you have not already
done so. Python is available from www.python.org.

To debug Python code with Wing, open up the Python file and select Start / Continue
from the Debug menu. This will run to the first breakpoint, unhandled exception, or until
the debug program completes. Select Step Into instead to run to the first line of code.
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Use the Debug 1/0 tool to view your program’s output, or to enter values for input to
the program. If your program depends on characteristics of the Windows Console or a
particular Linux/Unix shell, see External I/O Consoles for more information.

Duplicate explicit target name: “project properties”.

In some cases, you may also need to enter a PYTHONPATH and other environment values
using the Project Properties dialog available from the Project menu. This can also be
used to specify which Python executable should be used to run with your debug process.
Use this if Wing IDE cannot find Python on your system or if you have more than one
version of Python installed.

To set breakpoints, just click on the leftmost part of the margin next to the source code.

7.2. Specifying Main Entry Point

Normally, Wing will start debugging in whatever file you have active in the frontmost
editor. Depending on the nature of your project, you may wish to specify a file as the
default debug entry point. This is done with Set Main Debug File in the Debug menu.

This file is subsequently run whenever you start the debugger, except when using Debug
Current File in the Debug menu, or when right-clicking on an entry in the project manager
and choosing the Debug Selected context menu item.

Note that the path to the main debug file is highlighted in red in the project window.

The main entry point defined for a project is also used by the source code analysis engine
to determine the python interpreter version and Python path to use for analysis. Thus,
changing this value will cause all source files in your project to be reanalyzed from scratch.
See section Source Code Analysis for details.

7.3. Debug Properties

In some cases, you may need to set project and per-file properties from the Project manager
before you can debug your code. This is done to specify Python interpreter, PYTHONPATH,
environment variables, command line arguments, start directory, and other values associ-
ated with the debug process. For details, see Project-Wide Properties and Per-file
Properties.
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7.4. Setting Breakpoints

Breakpoints can be set on source code by opening the source file and clicking on the
breakpoint margin to the left of a line of source code. Right-clicking on the breakpoint
margin will display a context menu with additional breakpoint operations and options.
Alternatively, the Debug menu or the toolbar’s breakpoint icons can be used to set or clear
breakpoints at the current line of source (where the insertion cursor or selection is located).

7.5. Starting Debug

There are several ways in which to start a debug session from within Wing:

e Choose Start / Continue from the Debug menu or push the Debug icon in the
toolbar. This will run the main debug file if one has been defined (described in
Setting a Main Debug File), or otherwise the file open in the frontmost editor
window. Execution stops at the first breakpoint or exception, or upon program
completion.

e Choose Step Into from the Debug menu or push the Step Into icon in the toolbar.
This will run the main debug file if one has been defined, or otherwise the file open
in the frontmost editor window. Execution stops at the first line of code.

e Choose Debug Current File from the Debug menu or Debug Selected from the
right-click popup menu on the Project tool to run a specific file regardless of whether
a main debug file has been specified for your project. This will stop on the first
breakpoint or exception, or upon program completion.

e Choose Run to Cursor from the Debug menu or toolbar. This will run the main
debug file if one has been defined or otherwise the file open in the frontmost ed-
itor window. FExecution continues until it reaches the line selected in the current
source text window, until a breakpoint or exception is encountered, or until program
completion.

e Use Debug Recent in the Debug menu to select a recently debugged file. This will
stop on the first breakpoint or exception, or upon program completion.

e Use one of the key bindings given in the Debug menu.
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Additional options exist for initiating a debug session from outside of Wing and for attach-
ing to an already-running process. These are described in sections Debugging Externally
Launched Code and Attaching, respectively.

Once a debug process has been started, the status indicator in the lower left of the window
should change from white or grey to another color, as described in Debugger Status.

7.6. Debugger Status

The debugger status indicator in the lower left of editor Windows is used to display the state
of the debugger. Mousing over the bug icon shows expanded debugger status information
in a tool tip. The color of the bug icon summarizes the status of the debug process, as
follows:

e White -- There is no debug process, but Wing is listening for a connection from an
externally launched process.

Gray -- There is no debug process and Wing is not allowing any external process to
attach.

Green -- The debug process is running.

Yellow -- The debug process is paused or stopped at a breakpoint.

Red -- The debug process is stopped at an exception.

The current debugger status is also appended to the Debugger status group in the IDE’s
Messages tool.

7.7. Flow Control

Once the debugger is running, the following commands are available for controlling further
execution of the debug program from Wing. These are accessible from the tool bar and
the Debug menu:

e At any time, a freely running debug program can be paused with the Pause item
in the Debug menu or with the pause tool bar button. This will stop at the current
point of execution of the debug program.
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e At any time during a debug session, the Stop Debugging menu item or toolbar item
can be used to force termination of the debug program. This option is disabled by
default if the current process was launched outside of Wing. It may be enabled for
all local processes by using the Kill Externally Launched preference.

When stopped on a given line of code, execution can be controlled as follows from the
Debug menu or tool bar:

Step Over will step over a single byte code operation in Python. This may not leave the
current line if it contains something like a list comprehension or single-line for loop.

Step Into will attempt to step into the next executed function on the current line of code.
If there is no function or method to step into, this command acts like Step Over.

Step Out will complete execution of the current function or method and stop on the first
instruction encountered after returning from the current function or method.

Continue will continue execution until the next breakpoint, exception, or program termi-
nation

Run To Cursor will run to the location of the cursor in the frontmost editor, or to the
next breakpoint, exception, or program termination.

7.8. Viewing the Stack

Whenever the debug program is paused at a breakpoint or during manual stepping, the
current stack is displayed in the Call Stack tool. This shows all program stack frames
encountered between invocation of the program and the current run position. Outermost
stack frames are higher up on the list.

When the debugger steps or stops at a breakpoint or exception, it selects the innermost
stack frame by default. In order to visit other stack frames further up or down the stack,
select them in the Call Stack tool. You may also change stack frames using the Up Stack
and Down Stack items in the Debug menu, the up/down tool bar icons, the stack selector
popup menus the other debugging tools.

When you change stack frames, all the tools in Wing that reference the current stack frame
will be updated, and the current line of code at that stack frame is presented in an editor
window.

To change the type of stack display, right-click on the Call Stack tool and select from the
options for the display and positioning of the code line excerpted from the debug process.
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When an exception has occurred, a backtrace is also captured by the Exceptions notifi-
cation tool, where it can be accessed even after the debug process has exited.

7.9. Viewing Debug Data

Wing IDE allows you to inspect locals and globals using the Stack Data tool. This area
displays values for the currently selected stack frame.

Values Fetched on Demand

The variable data displayed by Wing is fetched from the debug server on the fly as
you navigate. Because of this, you may experience a brief delay when a change in an
expansion or stack frame results in a large data transfer.

For the same reason, leaving large amounts of debug data visible on screen may slow
down stepping through code.

7.9.1. Stack Data View

The Stack Data debugger tool contains a popup menu for selecting thread (in multi-
threaded processes) and accessing the current debug stack, a tree view area for browsing
variable data in locals and globals, and a textual view area for inspecting large data values
that are truncated on the tree display.

Simple values, such as strings and numbers, and values with a short string representation,
will be displayed in the value column of the tree view area.

Strings are always contained in "" (double quotes). Any value outside of quotes is a number
or internally defined constant such as None or E11ipsis.

Integers can be displayed as decimal, hexadecimal, or octal, as controlled by the Integer
Display Mode preference.

Complex values, such as instances, lists, and dictionaries, will be presented with an angle-
bracketed type and memory address (for example, <dict 0x80ce388>) and can be ex-
panded by clicking on the expansion indicator in the Variable column. The memory
address uniquely identifies the construct. If you see the same address in two places, you
are looking at two object references to the same instance.

If a complex value is short enough to be displayed in its entirety, the angle-bracketed form
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is replaced with its value, for example {’a’: ’b’} for a small dictionary. These short
complex values can still be expanded in the normal way.

Upon expansion of complex data, the position or name of each sub-entry will be displayed
in the Variable column, and the value of each entry (possibly also complex values) will be
displayed in the Value column. Nested complex values can be expanded indefinitely, even
if this results in the traversal of cycles of object references.

Once you expand an entry, the debugger will continue to present that entry expanded,
even after you step further or restart the debug session. Expansion state is saved for the
duration of your Wing IDE session.

When the debugger encounters a long string, it will be truncated in the Value column.
In this case, the full value of the string can be viewed in the textual display area at the
bottom of the Stack Data tool, which is accessed by right-clicking on a value and selecting
Show Detail. The contents of the detail area is updated when other items in the Stack
Data tool are selected.

Opaque Data

Some data types, such as those defined only within C/C++ code, or those containing
certain Python language internals, cannot be transferred over the network. These
are denoted with Value entries in the form <opaque 0x80ce784> and cannot be
expanded further.

7.9.1.1. Popup Menu Options

Right-clicking on the surface of the Stack Data view displays a popup menu with options
for navigating data structures:

e Show/Hide Detail -- Used to quickly show and hide the split where Wing shows
expanded copies of values that are truncated on the main debug data view (click on
items to show their expanded form).

e Expand More -- When a complex data value is selected, this menu item will expand
one additional level in the complex value. Since this expands a potentially large
number of values, you may experience a delay before the operation completes.

e Collapse More -- When a complex data value is selected, this menu item will
collapse its display by one additional level.

e Force Reload -- This forces Wing IDE to reload the displayed value from the de-
bug process. This is useful in cases where Wing is showing an evaluation error or
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when the debug program contains instances that implement __repr__ or similar spe-
cial methods in a way that causes the value to change when subjected to repeated
evaluation.

7.9.1.2. Filtering Value Display

There are a number of ways in which the variable displays can be configured:

Wing lets you prune the variable display area by omitting all values by type, and
variables or dictionary keys by name. This is done by setting the two preferences,
Omit Types and Omit Names.

You can also tell Wing to avoid probing certain values by data type. This is useful
to avoid attempting expansion of data values defined in buggy extension modules,
which can lead to crashing of the debug process as the debugger invokes code that
isn’t normally executed. To add values to avoid, set preference Do Not Expand.

Wing provides control over size thresholds above which values are considered too
large to move from the debug process into the variable display area. Values found
to be too large are annotated as huge in the variable display area and cannot be
expanded further. The data size thresholds are controlled with preferences Huge
List Threshold and Huge String Threshold.

By default Wing will display small items on a single line in the variable display areas,
even if they are complex types like lists and maps. The size threshold used for this
is controlled with preference Line Threshold. If you want all values to be shown
uniformly, this preference should be set to 0.

7.9.2. Problems Handling Values

The Wing debugger tries to handle debug data as gently as possible to avoid entering into
lengthy computations or triggering errors in the debug process while it is packaging debug
data for transfer. Even so, not all debug data can be shown on the display. This section
describes each of the reasons why this may happen:

Wing may time out handling a value -- Large data values may hang up the debug
server process during packaging. Wing tries to avoid this by carefully probing an object’s
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size before packing it up. In some cases, this does not work and Wing will wait for the
data for the duration set by the Network Timeout preference and then will display the
variable value as <network timeout during evaluate>.

Wing may encounter values too large to handle -- Wing will not package and transfer
large sequences, arrays or strings that exceed the size limits set by Huge List Threshold
and Huge String Threshold preferences. On the debugger display, oversized sequences
and arrays are annotated as huge and <truncated> is prepended to large truncated strings.

To avoid this, increase the value of the threshold preferences, but be prepared for longer
data transfer times. Note that setting these values too high will cause the debugger to
time out if the Network Timeout value isn’t also increased.

Wing may encounter errors during data handling -- Because Wing makes assign-
ments and comparisons during packaging of debug data, and because it converts debug
data into string form, it may execute special methods such as __cmp__ and __str__ in
your code. If this code has bugs in it, the debugger may reveal those bugs at times when
you would otherwise not see them.

The rare worst case scenario is crashing of the debug process if flawed C or C++ extension
module code is invoked. In this case, the debug session is ended.

More common, but still rare, are cases where Wing encounters an unexpected Python
exception while handling a debug data value. When this happens, Wing displays the value
as <error handling value>.

These errors are not reported as normal program errors in the Exceptions tool. However,
extra output that may contain the exception being raised can be obtained by setting the
Debug Internals Log File preference.

Stored Value Errors

Wing remembers errors it encounters on debug values and stores these in the project file.
These values will not be refetched during subsequent debugging, even if Wing is quit and
restarted.

To override this behavior for an individual value, use the Force Reload item in the right-
click context menu on a data value.

To clear the list of all errors previously encountered so that all values are reloaded, use the
Clear Stored Value Errors item in the Debug menu. This operates only on the list of
errors known for the current debug file, if a debug session is active, or for the main debug
file, if any, when no debug process is running.
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7.10. Debug Process I/0

While running under the Wing debugger, any output from print or any writes to stdout
or stderr will be seen in the Debug I/0 tool. This is also where you enter keyboard
input, if your debug program requests any with input() or raw_input() or by reading
from stdin.

The code that services debug process I/O does two things: (1) any waits on sys.stdin are
multiplexed with servicing of the debug network socket, so that the debug process remains
responsive to Wing IDE while waiting for keyboard input, and (2) in some cases, /O is
redirected to another window.

For a debug process launched from within Wing, keyboard 1/O always occurs either in
the Debug I/O tool or in a new external console that is created before the debug process
is started. This can be controlled as described in External I/O Consoles. Using an
external console is recommended when printing very large amounts of output from a debug
process.

Debug processes launched outside of Wing, using wingdbstub, always do their keyboard
I/O through the environment from which they were launched (whether that’s a console
window, web server, or any other I/O environment).

7.10.1. External I/O Consoles

In cases where the debug process requires specific characteristics provided by the Windows
Console or specific Linux/Unix shell, or to better handle very large amounts of debug
process output, you can redirect debug I1/O to a new external window using the Use
External Console preference.

The most effective way to keep the external console visible after the debug process exits is
to place a breakpoint on the last line of your program. Alternatively, enable the External
Console Waits on Exit preference. However, this can result in many external consoles
being displayed at once if you do not press enter inside the consoles after each debug run.

On Linux/Unix it is possible to select which console applications will be tried for the
external console by altering the External Consoles preference.

Windows always uses the standard DOS Console that comes with your version of Windows.
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7.10.2. Disabling Debug Process I1/0 Multiplexing

Wing alters the I/O environment in order to make it possible to keep the debug process
responsive while waiting for I/O. This code mimics the environment found outside of the
debugger, so any code that uses only Python-level I/O does not need to worry about this
change of environment.

There are however several cases that can affect users that bypass Python-level I/O by doing
C/CH+ level I/O from within an extension module:

e Any C/C++ extension module code that does standard 1/O calls using the C-level
stdin or stdout will bypass Wing’s 1/O environment (which affects only Python-
level stdin and stdout). This means that waiting on stdin in C or C++ code will
make the debug process unresponsive to Wing, causing time out and termination of
the debug session if you attempt to Pause or alter breakpoints at that time. In this
case, redirection of 1/O to the debugger 1/O tool and Debug Probe (in Wing Pro
only) will also not work.

e On all platforms, calling C-level stdin from multiple threads in a multi-threaded
program may result in altered character read order when running under the Wing
debugger.

e When debugging on win32, calling C-level stdin, even in a single-threaded program,
can result in a race condition with Wing’s I/O multiplexer that leads to out-of-order
character reads. This is an unavoidable result of limitations on multiplexing keyboard
and socket I/O on this platform.

If you run into a problem with keyboard I/0O in Wing’s debugger, you should:
1) Turn off Wing’s I/O multiplexer by setting the Use sys.stdin Wrapper pref-
erence to False.
2) Turn on the Use External Console preference (for details see External I/0

Consoles)

Once that is done, I/O should work properly in the external console, but the debug process
will remain unresponsive to Pause or breakpoint commands from Wing IDE whenever it
is waiting for input, either at the C/C++ or Python level.
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7.11. Debugging Multi-threaded Code

Wing’s debugger can debug multi-threaded code, as well as single-threaded code. By
default, Wing will debug all threads and will stop all threads if a single thread stops. If
multiple threads are present in the debug process, the Stack Data tool (and in Wing Pro
the Debug Probe and Watch tools) will add a thread selector popup to the stack selector.

Even though Wing tries to stop all threads, some may continue running if they do not
enter any Python code. In that case, the thread selector will list the thread as running. It
also indicates which thread was the first one to stop.

When moving among threads in a multi-threaded program, the Show Position icon shown
in the toolbar during debugging (between the up/down frame icons) is a convenient way
to return to the original thread and stopping position.

Whenever debugging threaded code, please note that the debugger’s actions may alter the
order and duration that threads are run. This is a result of the small added overhead,
which may influence timing, and the fact that the debugger communicates with the IDE
through a TCP/IP connection.

Selecting Threads to Debug

Currently, the only way to avoid stopping all threads in the debugger is to launch your
debug process from outside Wing, import wingdbstub, and use the debugger API’s Set-
DebugThreads () call to specify which threads to debug. All other threads will be entirely
ignored. This is documented in Debugging Externally Launched Code and the API
is described in Debugger API

An example of this can be seen in the file DebugHttpServer.py that ships with Wing’s
support for Zope and Plone. To see this, unpack the WingDBG archive found inside the
zope directory in your Wing installation.

Note, however, that specifying a subset of threads to debug may cause problems in some
cases. For example, if a non-debugged thread starts running and does not return control
to any other threads, then Wing’s debugger will cease to respond to the IDE and the
connection to the debug process will eventually be closed. This is unavoidable as there is
no way to preemptively force the debug-enabled threads to run again.
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7.12. Managing Exceptions

By default, Wing’s debugger stops at exceptions when they would be printed by the Python
interpreter. This means that any code in finally clauses, except clauses that reraise the
exception, and with statement cleanup routines will be executed before the debugger stops.

The Exception Reporting preference can be used to choose different ways of reporting
exceptions. The following choices are available:

When Printed (default) -- The debugger will stop on exceptions at the time that they
would have been printed out by the Python interpreter.

For code with catch-all exceptions written in Python, Wing may fail to report unexpected
exceptions if the handlers do not print the exception. In this case, it is best to rewrite the
catch-all handlers as described in Trouble-shooting Failure to Stop on Exceptions.

Always Immediately -- The debugger will stop at every single exception immediately
when it is raised. In most code this will be very often, since exceptions may be used
internally to handle normal, acceptible runtime conditions. As a result, this option is
usually only useful after already running close to a code that requires further examination.

At Process Termination -- In this case, the debugger will make a best effort to stop
and report exceptions that actually lead to process termination. This occurs just before or
sometimes just after the process is terminated. The exception is also printed to stderr,
as it would be when running outside of the debugger.

When working with an Externally Launched Debug Process , the At Process Ter-
mination mode may not be able to stop the debug process before it exits, and in some
cases may even fail to show any post-mortem traceback at all (except as printed to stderr
in the debug process).

Similarly, when working with wxPython, PyGTK, and similar environments that include
a catch-all exception handler in C/C++ code, the At Process Termination mode will
fail to report any unexpected exceptions occurring during the main loop because those
exceptions do not actually lead to process termination.

Immediately if Appear Unhandled -- The debugger will attempt to detect unhandled
exceptions as they are raised in your debug process, making it possible to view the program
state that led to the exception and to step through subsequently reached finally clauses.
This is done by looking up the stack for exception handlers written in Python, and reporting
only exceptions for which there is no matching handler.

The Immediately if Appear Unhandled mode works well with wxPython, PyGTK, and
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in most other code where unexpected exceptions either lead to program termination or are
handled by catch-all exception handlers written in C/C++ extension module code.

In some cases, Wing’s unhandled exception detector can report normal handled exceptions
that are not seen outside of the debugger. This occurs when the exceptions are handled
in C/C++ extension module code. Wing can be trained to ignore these by checking the
Ignore this exception location check box in the debugger’s Exception tool. Ignored
exceptions are still reported if they actually lead to program termination, and your selection
is remembered in your project file so only needs to be made once. Use Clear Ignored
Exceptions from the Debug menu at any time to reset the ignore list to blank.

In general, we recommend using either the When Printed or the Immediately if Appear
Unhandled exception reporting mode.



Advanced Debugging Topics

This chapter collects documentation of advanced debugging techniques, including debug-
ging externally launched code, and using Wing’s debugger together with a debugger for
C/C++ code.

See also the collection of How-Tos for tips of working with specific third party libraries
and frameworks for Python.

8.1. Debugging Externally Launched Code

This section describes how to start debugging from a process that is not launched by
Wing. Examples of debug code that is launched externally include CGI scripts or web
servlets running under a web server and embedded Python scripts running inside a larger
application.

8.1.1. Importing the Debugger

The following step-by-step instructions can be used to start debugging in externally
launched code that is running on the same machine as Wing IDE:

1) Copy wingdbstub.py from the Wing IDE installation directory into the same
directory as your debug program.

2) In some cases, you will also need to copy the file wingdebugpw from your User
Settings Directory into the same directory as wingdbstub.py. This is needed
when running the debug process as a different user or in a way that prevents
the debug process from reading the wingdebugpw file from within your User
Settings Directory.
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3) At the point where you want debugging to begin, insert the following source
code: import wingdbstub Depending on your code base, you may need to be
cautious about whether this statement is reached by multiple processes. If this
happens, the first process will connect to Wing and the second one will fail to
connect and continue running without debug.

4) Make sure the Wing IDE preference Enable Passive Listen is turned on, to
allow connection from external processes.

5) Set any required breakpoints in your Python source code.

6) Initiate the debug program from outside Wing IDE, for example with a page
load in your web browser, if the program is a web app. You should see the
status indicator in the lower left of the main Wing IDE window to yellow, red,
or green, as described in Debugger Status. Make sure that you are running
the Python interpreter without the -0 option. The debugger will not work
when optimization is turned on.

7) The debugger should stop at the first breakpoint or exception found. If no
breakpoint or exception is reached, the program will run to completion, or you
can use the Pause command in the Debug menu.

Enabling Process Termination
In some cases, you may wish to enable termination of debug processes that were
launched from outside of Wing IDE. By default, Wing recognizes externally launched
processes and disables process termination in these cases unless the Kill Externally
Launched preference is enabled.

If you have problems making this work, try setting kLogFile variable in wingdbstub.py
for log additional diagnostic information.

Behavior on Failure to Attach to IDE

Whenever the debugger cannot contact Wing IDE (for example, if the IDE is not
running or is listening on a different port), the debug program will be run without
debugging. This is useful since debug-enabled CGls and other programs should work
normally when Wing is not present. However, you can force the debug process to exit
in this case by setting the kExitOnFailure flag in wingdbstub.py.
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8.1.2. Debug Server Configuration

In some cases you may also need to alter other preset configuration values at the start
of wingdbstub.py. These values completely replace any values set in Wing’s Project or
File Properties, which are relevant only when the debug program is launched from within
Wing. The following options are available:

e The debugger can be disabled entirely with kWingDebugDisabled=1. This is equiva-
lent to setting the WINGDB_DISABLED environment variable before launching the debug
program.

e Set kWingHostPort to specify the network location of Wing IDE, so the debugger
can connect to it when it starts. This is equivalent to setting the WINGDB_HOSTPORT
environment variable before launching the debug program. The default value is lo-
calhost:50005. See section Remote Debugging for details if you need to change
this value.

e You can control whether or not the debugger’s internal error messages are written
to a log file by setting kLogFile. Use <stdout>, <stderr>, or a file name. If the
given file doesn’t exist, it is created if possible. Note that using <stderr> may
cause problems on Windows if the debug process is not running in a console. This
is equivalent to setting the WINGDB_LOGFILE environment variable before launching
the debug program (use a value of - to turn off logging to file).

e Set kEmbedded to 1 when debugging embedded scripts. In this case, the debug
connection will be maintained across script invocations instead of closing the debug
connection when the script finishes. When this is set to 1, you may need to call
wingdbstub.debugger.ProgramQuit () before your program exits in order to cleanly
close the debug connection to the IDE. This is equivalent to setting the environment
variable WINGDB_EMBEDDED.

e Set kAttachPort to define the default port at which the debug process will listen
for requests to attach (available in Wing IDE Professional only). This is equivalent
to setting the WINGDB_ATTACHPORT environment variable before launching the debug
program. If this value is less than 0, the debug process will never listen for attach
requests. If it is greater than or equal to 0, this value is used when the debug process
is running without being in contact with Wing IDE, as might happen if it initially
fails to connect to the above-defined host and port, or if the IDE detaches from the
process for a period of time.

e Set kPWFilePath and kPWFileName to define the search path and file name
used to find a wingdebugpw file for the debugger. The environment variables
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WINGDB_PWFILEPATH and WINGDB_PWFILENAME will override these settings. The file
path should be a Python list of strings if set in wingdbstub.py or a list of directories
separated by the path separator (os.pathsep) when sent by environment variable.
The string $<winguserprofile> may be used to specify Wing’s User Settings Di-
rectory for the user that the debug process is running as. The password file name is
usually wingdebugpw but may be changed in cases where this naming is inconvenient.

e Optionally, set WINGHOME, which is the location of the Wing IDE distribution’s home
directory. This is set up during installation, but may need to be altered if you are
running Wing from source or copied the debugger binaries over from another machine.

Setting any of the above-described environment variable equivalents will override the value
given in the wingdbstub.py file.

8.1.3. Debugger API

A simple API can be used to control debugging more closely, once you have imported
wingdbstub.py the first time, as was described in section Importing the Debugger.

This is useful in cases where you want to be able to start and stop debugging on the fly
several times during a debug run, for example to avoid debug overhead except within a
small sub-section of your code. It can also be useful in embedded scripting environments.

To use the API, take the following steps: (1) Configure and import wingdbstub.py as de-
scribed in section Importing the Debugger. (2) Subsequently, use the instance variable
wingdbstub.debugger to make any of the following calls:

e StartDebug(stophere=0, autoquit=1, connect=1) -- Start debugging, option-
ally connecting back to the IDE and/or stopping immediately afterwards. Set au-
toquit=0 to avoid automatically terminating debug when program exit is detected
(this is the same as setting kEmbedded in wingdbstub.py).

e StopDebug() - Stop debugging completely and disconnect from Wing IDE. The
debug program continues executing in non-debug mode and must be restarted to
resume debugging.

e SuspendDebug() - This will leave the connection to the debug client intact but
disables the debugger so that connection overhead is avoided during subsequent ex-
ecution.
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ResumeDebug() - This will resume debugging using an existing connection to

Wing.

Break() -- This pauses the free-running debug program on the current line, as if at
a breakpoint.

ProgramQuit() - This must be called before the debug program is exited if kEmbed-
ded was set to 1 in wingdbstub.py or if autoquit=0 in the preceding StartDebug()
APT call (if any). This makes sure the debug connection to the IDE is closed cleanly.

SetDebugThreads(threads={}, default_policy=1) - This can be used in multi-
threaded code to tell Wing’s debugger which threads to debug. Pass in a dictionary
that maps from thread id (as obtained from thread.get_ident()) to one of the following
values: 0 to ignore the thread (do not debug it), or 1 to debug the thread and
immediately stop it if any thread stops. The default_policy sets the action to take
when a thread is not found in the thread map.

Here is a simple usage example:

import wingdbstub

a = 1 # This line is debugged
wingdbstub.debugger . SuspendDebug ()

x = 1 # This is executed without debugging
wingdbstub.debugger.ResumeDebug ()

y = 2 # This line is debugged again

SuspendDebug () and ResumeDebug() can be called as many times as desired, and nested
calls will be handled so that debugging is only resumed when the number of ResumeDebug ()
calls matches the number of SuspendDebug() calls.

8.2. Remote Debugging

Since remote debugging is fairly complicated to configure, we currently recommend using
remote display of the IDE via X Windows (Linux/Unix) or Remote Desktop (Windows)
when possible, instead of setting up the IDE on a separate host from the debug process.

When this is not an option, you can also ask the debugger to connect remotely over the
network. In order to do this, take the following steps (see also Remote Debugging
Example):
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(1) First set up Wing IDE to successfully accept connections from another process within
the same machine, as described in section Importing the Debugger. You can use any
Python script for testing this until you have values that work.

(2) Optionally, alter the Server Host preference to the name or IP address of the network
interface on which the IDE listens for debug connections. The default server is None, which
indicates that the IDE should listen on all the valid network interfaces on the host.

(3) Optionally, alter the preference Server Port to the TCP/IP port on which the IDE
should listen for debug connections. This value may need to be changed if multiple copies
of Wing IDE are running on the same host.

(4) Set the Allowed Hosts preference to include the host on which the debug process will
be run. For security purposes, Wing will reject connections if the host isn’t included here.

(5) Configure any firewall on the system that Wing IDE is running on to accept a connection
on the server port from the system that the debug process will run on.

(6) Next install Wing IDE on the machine on which you plan to run your debug program.
Creating an entire Wing IDE installation is the easiest approach. Alternatives are to copy
only the debug server code out of a Wing installation on the same type of OS or to compile
the debugger core from source code. For details, see Installing the Debugger Core.

(7) Next, transfer copies of all your debug code so that the source files are available on
the host where Wing IDE will be running and at least the *.pyc files are available on the
debug host.

During debugging, the client and server copies of your source files must match or the
debugger will either fail to stop at breakpoints or stop at the wrong place, and stepping
through code may not work properly.

Since there is no mechanism in Wing IDE for transferring your code, you need to use NF'S,
Samba, FTP or some other file sharing or file transfer mechanism to keep the remote files
up to date as you edit them in Wing.

If files appear in different disk locations on the two machines, you will also need to set up
a file location map, as described in File Location Maps.

(8) On your debug host, copy wingdbstub.py into the same directory as your source files
and import it in your Python source as described in Debugging Externally Launched
Code.

(9) If you didn’t copy wingdbstub.py out of a complete installation of Wing IDE on the
debug host, you will need to set kWingHome to match the location where you have copied
the debug server code on your debug host.
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(10) In wingdbstub.py on your debug host, set kWingHostPort. The host in this value
must be the IP address of the machine where Wing IDE is running. The port must match
the port configured with the Server Port preference on the host where Wing IDE is
running.

(11) Then restart Wing and try running your program on the debug host. You should see
the Wing IDE debugger status icon change to indicate that a debug process has attached.

If you have problems making this work, try setting kLogFile variable in wingdbstub.py
for log additional diagnostic information.

8.2.1. File Location Maps

In cases where the full path to your source is not the same on both machines, you also need
to set up a mapping that tells Wing where it can find your source files on each machine.

This is done with the Location Map preference, which lists corresponding local and
remote directory locations for each remote host’s dotted quad IP address.

One of the host IP addresses within this preference can be set to "x" to define a default
mapping for all hosts that are not otherwise specified in the location map.

Each host IP address in the location map is paired with one or more (remote_prefix,
local_prefix) tuples. The remote file prefix will be a full path on the debug server’s file
system. The local file prefix should be a URL, optionally starting with file: (this URL
should not contain backslashes (\), even if the local host is a Windows machine) or a UNC
\\server\share\dir style path name.

The best way to understand this is to look at the Location Map Examples.

When running Wing IDE on Windows XP, UNC formatted file names such as \\ma-
chine\path\to\file may be used. On other Windows systems, you must map remote
drives to a drive letter such as F:. In cases where setting up a persistent drive mapping is
a problem, use a cmd.exe script with a net use command to map the drive on demand.

Note that making symbolic links on the client or server will not work as an alternative to
using this mapping. This is a side-effect of functionality in the debugger that ensures that
debugging works right when symbolic links are present: Internally, source file names are
always resolved to their actual full path location.
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8.2.1.1. File Location Map Examples

The best way to understand location mapping is to inspect a few examples.
Defaults Explained

The default value for the Location Map preference contains one entry for
127.0.0.1 where the mapping is set to None (in Python this is represented as
{’127.0.0.1’:None}). This is equivalent to the more verbose Python representation of
{’127.0.0.1°:[(’/’,’file:?)]}. It converts full paths on the debug server to the client-
side URLs without altering any part of the full path.

Two Linux/Unix Hosts

Here is an example setting for debug.location-map that would be used if running Wing
on desktopl and debugging some code on serverl with IP address 192.168.1.1:

debug.location-map={

’127.0.0.17 :None,

7192.168.1.17: [(’ /home/apache/cgi’, ’file:/svrl/home/apache/cgi’)]
}

In this example, the files located in /home/apache/cgi on serverl are the same files seen
in /serverl/home/apache/cgi on desktopl because the entire file system on server1 is
being shared via NFS and mounted on desktopl under /svrl.

To enter this value in Preferences, you would add 192.168.1.1 as a new Remote
[P Address and a single local/remote mapping pair containing /home/apache/cgi and
file:/svril/home/apache/cgi.

IDE on Linux/Unix with Debug Process on Windows

If you are debugging between Windows and Linux or Unix, some care is needed in specifying
the conversion paths because of the different path name conventions on each platform. The
following entry would be used when running Wing IDE on a Linux/Unix host and the debug
process on a Windows host with ip address 192.168.1.1:

debug.location-map={

7127.0.0.1’ :None,

7192.168.1.17: [(r’e:\src’, ’file:/home/myuser/src’)],
}
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In this example the Linux/Unix directory /home/myuser is being shared via Samba to the
Windows machine and mapped to the e: drive.

In the Preferences GUI, you would add 192.168.1.1 as a new Remote IP Address and a
single local /remote mapping pair containing e:\src and file:/home/myuser/src.

IDE on Windows with Debug Process on Linux/Unix

If running Wing IDE on a Windows host and the debug process on a Linux/Unix host with
IP address 192.168.1.1, the following would be used instead for the same file locations:

debug.location-map={

7127.0.0.1’ :None,

’192.168.1.1°: [(’ /home/myuser/src’, ’file:e:/src’)],
}

Again, note the use of forward slashes in the URL even though the file is on a Windows
machine.

In the Preferences GUI, you would add 192.168.1.1 as a new Remote IP Address and a
single local /remote mapping pair containing /home/myuser/src and file:/e:/src.

Two Windows Hosts
If running Wing IDE on Windows and the debug process on another Windows machine

with IP address 192.168.1.1, the following would be used:

debug.location-map={

7127.0.0.17 :None,

7192.168.1.1° : [(r’c:\src’, ’file:e:/src’)],
}

In this case, the host where Wing is running has mapped the entire remote (debug process)
host’s c: drive to e:.

In the Preferences GUI, you would add 192.168.1.1 as a new Remote IP Address and a
single local /remote mapping pair containing c:\src and file:e:/src.

Two Windows Hosts using UNC Share

A UNC style path name can be used on Windows XP as follows:

debug.location-map={
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’127.0.0.1° :None,
7192.168.1.17: [(xr’c:\src’, ’\\server\share\dir’)],
+

In this case, c:src on the remote host, where the debug process is running, can be accessed
as \serversharedir on the machine where Wing IDE is running.

In the Preferences GUI, you would add 192.168.1.1 as a new Remote IP Address and a
single local /remote mapping pair containing c:\src and \\server\share\dir.

8.2.2. Remote Debugging Example

Here is a simple example that enables debugging a process running on a Linux/Unix host
(192.168.1.200) using Wing IDE running on a Windows machine (192.168.1.210). This
example is for wingdbstub users only. If you are using the WingDBG product to debug
Zope code, please refer to the Zope Debugging How-To (also included in the WingDBG
control panel’s Help tab).

On the Windows machine, the following preferences must be specified:

e Enable Passive Listen should be checked
e Server Host should be set to A1l Interfaces (this is the default)
e Server Port should be set to 50005 (this is the default)

e Allowed Hosts should be altered by adding 192.168.1.200
On the Linux/Unix machine, the following value is needed in wingdbstub. py:
kWingHostPort=’192.168.1.210:50005’

Once this is done and Wing has been restarted, you should be able to run code that
imports wingdbstub on the Linux/Unix machine and see the debug connection establish
on the Windows machine.

Then you will need to set up file sharing between the two machines (for example, using
Samba) and will need to establish a location map in your Wing IDE preferences on the
Windows machine.
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If your source code on the Linux/Unix machine is in /home/myuser/mysource and you
map /home/myuser to e: on the Windows machine, then you would use the following
location map in conjunction with the above settings:

debug.location-map=(’192.168.1.200°: [(’/home/myuser/mysource’, \
>file:e:/mysource’)]}

To enter this location map via the Preferences GUI, you would add 192.168.1.200 as a
new Remote Host IP and enter a single mapping pair with /home/myuser/mysource and
file:e:/mysource.

See Location Map Examples for additional examples.

8.2.3. Installing the Debugger Core

When Wing is used to debug a Python program remotely, the Wing debugger core must
be installed on the remote machine. The easiest way to do that is just to install Wing IDE
there. If that is not possible, there are two options: (1) Copy just the debugger files from
a Wing IDE installation on the same type of machine, or (2) compile the debugger core
from sources (available for Wing IDE Professional only).

Copying from Wing IDE Installation

When copying from an existing Wing IDE installation on another machine, you will need
to copy all of the following files and directories under WINGHOME:

wingdbstub.py bin/wingdb.py bin/#.# /src/debug/tserver bin/#.# /src.zip/debug/tserver
(only Python 2.5) bin/#.#/opensource/schannel (Python versions other than
2.5) bin/#.# /opensource.zip/schannel (only Python 2.5)

Replace #.# with each version Python you wish to debug under (for example, 2.5). You
can omit the directories for the versions that you are not using.

The directories within zip files (used only in Python 2.5 and later) can either be copied
by moving the entire zip file or by creating a subset that contains only the necessary
directories.

Be sure to copy these directories from a Wing installation on